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Dr. Abdul Razaq Touqan 

 

Abstract 

A need for a computer program to analyze and design reinforced concrete 

sections for both academic education and engineering offices’ services is 

beyond doubt. Also, a need for having programs in Arabic language to help 

in communication of engineers graduated from all over the world is 

becoming increasingly important. 

This thesis presents a computer program that tries to fulfill previous needs 

based on ACI code and presented in both Arabic and English languages, 

and uses local and international units. 

The computer program; Analysis and Design of Reinforced Concrete 

Sections; AD RCS; is constructed using Visual Basic 6 programming 

language. The input and output data are performed using dialog boxes in 

windows environment. 

The program has the ability of analyzing reinforced concrete sections of 

beams, columns and single footings and also design them for flexure, shear, 

axial and torsion. It also introduces capacity interaction diagrams and 

section reinforcement details. 
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The command buttons Column P_M3 Diagram and Column P_M2 diagram 

in the Show Design Results dialog in Figure 3.33, calculate the interaction 

points of the axial force-bending moment in the major and minor directions 

of the column respectively and then convert these points to drawings. The 

flowcharts of these command buttons were discussed in section 3.9.1 in the 

Start Analysis/Show Results submenu. 

The command button Bars Layout displays reinforcement details for the 

section as shown in Figure 3.36 (form name: BarsLayout, file: 

BarsLayout.frm). 

Figure 3.36 Show Bars Layout dialog 

The bars diameters can be modified using the Change Bars Diameters 

dialog as shown in Figure 3.37 (from name:  ChangeBarDiameter, file: 

ChangeBarDiameter.frm).  

The command button Load Combinations displays the load combinations 

design results in the Show Design Output dialog as shown in Figure 3.38 

(form name: CombinationsOut, file: CombinationsOut).  



  195

Figure 3.37 Change Bars Diameters dialog 
 

Figure 3.38 Show Design Output dialg for output results of load 
combinations 

The details for each load combination is displayed by clicking on the 

command button Details in the Show Beam Section design dialog as shown 

in Figure 3.39 (form name: Details, file: DesignDetails).  

The command button Footing Design runs a subroutine for footing design, 

then the design results are displayed in the Show Footing Design dialog as 

shown in Figure 3.40 (form name: Details, file: DesignDetails).  
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Figure 3.39 Show Column Section Design dialog  

Figure 3.40 Show Footing Design dialog  
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The footing reinforcement details are displayed by clicking on the menu 

Bars Layout. Figure 3.41 shows the Show Bars Layout dialog (form name: 

BarsLayout, file: BarsLayout). The bars diameters can be modified by 

displaying the Change Bar Diameters dialog as shown in Figure 3.42 (form 

name: ChangeBarDiameter, file: ChangeBarDiameter).  

Figure 3.41 Show Bars Layout dialog/ Footing 

Figure 3.42 Change Bars Diameters dialog/ Footing 

The Footing Design command button runs a subroutine for footing design. 

The flowchart of this subroutine is shown in Figure 3.43.  

The variables in this flowchart are defined as follows: 
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Element_Footing_Load(SL1)= the ultimate load on the footing for design 

FootingID1(SL1)= identifier for the footing load if it is tension or not. 1: 

footing load is tension, 0: footing load is compression 

FootingVuL(SL1)= shear force at distance d from face of column in 

direction L 

FootingPhiVc(SL1)= concrete shear capacity of footing section 

FootingEDepth(SL1)= footing effective depth 

FootingMuL(SL1)= bending moment at face of column in direction L 

FotTmin= minimum footing thickness 

FootingMuB(SL1)= bending moment at face of column in direction B 

Df_Punching= footing effective depth due to punching  

FootingAstB(SL1)= design area of steel in footing section in direction B 

FootingLength(SL1)= design footing length 

FootingWidth(SL1)= design footing width 

FootingHeight(SL1)= design footing thickness 

FootingEdepthWide(SL1)= footing effective depth due to wide beam 

shear 

FootingEdepthPunching(SL1)= footing effective depth due to punching 

AstShort= area of steel in direction B 

Beta= ratio of footing length,L to footing width, B 

FootingVuB(SL1)= shear force at face of column in direction B 

FootingAstBC(SL1)= area of steel in short direction at center 

FootingAstBS(SL1)= area of steel in short direction outsides the center 

FootingBarsL(SL1)= number of bars in direction L 

FootingBarsBC(SL1)= number of bars in short direction, B at the center 

FootingBarsBS(SL1)= number of bars in short direction, B outsides the 

cnter 
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FootingBarsB(SL1)= total number of bars in direction B 

 
 

 

Figure 3.43 Flowchart for footing design 

Start

Read variables: 
Element_Footing_Material(SL1)= Material_Name(Element_SectionID(SL1)) 
Element_Footing_Fc(SL1)= Material_Fc(Element_SectionID(SL1)) 
Element_Footing_Fy(SL1)= Material_Fy(Element_SectionID(SL1)) 
Element_Footing_LoadFactor(SL1)= 
Sections_Footing_LoadFactor(Element_SectionID(SL1)) 
Element_Footing_Soil_Capacity(SL1)= 
Sections_Footing_Soil_Capacity(Element_SectionID(SL1)) 
Element_Footing_Cover(SL1)= 
Sections_Footing_Cover(Element_SectionID(SL1)) 
Element_Footing_Load(SL1)= maximum axial load from column load 
combinations 
FootingID1(SL1)=1 the axial force is tension, end subroutine 
FootingID1(SL1)=0 the axial force is compression, continue

Units ID=Ton Meter

PUF=Element_Footing_Load(SL1) 
Fc=Element_Footing_Fc(SL1)/10  kg/cm2 
Fy=Element_Footing_Fy(SL1)/10  kg/cm2 
BearingCapacity=Element_Footing_Soil_Capacity(SL1)

Yes 

PUF=Element_Footing_Load(SL1)/9.80665 
Fc=Element_Footing_Fc(SL1)/98.0665  kg/cm2 
Fy=Element_Footing_Fy(SL1)/98.0665  kg/cm2 
BearingCapacity=Element_Footing_Soil_Capacity(SL1)/9.80665 

A
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Figure 3.43 continued 

Df_Punching>Df

Df=Df_Punching 

Yes 

FootingEDepth(SL1)=Df

B

Footing_Mu 
Footing_Vu 

A

LoadFactor=Element_Footing_LoadFactor(SL1) 
BC=Element_B(SL1) 
HC=Element_H(SL1) 
Footing_Design_Area 
FootingCArea(SL1)=FootingArea 
Footing_Qu 
B=100 cm 
LengthF=LT 
LengthC=HC 
Footing_WideBeamShear_Df 
Footing_Punching_Vcp 
Footing_PunchingShear_Df 
Df=Df_Wide 
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Figure 3.43 continued 

B

Units_ID=Ton_Meter

FootingMuL(SL1)=Muf 
FootingVuL(SL1)=Vuf 
FootingPhiVc(SL1)=PhiV

Yes 

FootingMuL(SL1)=Muf*9.80665 
FootingVuL(SL1)=Vuf*9.80665 
FootingPhiVc(SL1)=PhiVc*9.80665
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Figure 3.43 continued 

Mu=Muf 
Dc=Element_Footing_Cover(SL1)*100 cm 
Dt=Element_Footing_Cover(SL1)*100 cm 
HT=Df+Element_Footing_Cover(SL1) > FotTmin 
H=HT*100 cm 
Rectangular_Section_Design 
Footing_MinSteel 

minss AA <  

minss AA =  

Yes

FootingAstL(SL1)=As*BT 
LengthF=BT 
LengthC=BC 
Footing_Mu 
Footing_Vu

C

C 

Units_ID=Ton_Meter
Yes 
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FootingMuB(SL1)=Muf 
FootingVuB(SL1)Vuf 

FootingMuB(SL1)=Muf*9.80665 
FootingVuB(SL1)=Vuf*9.80665 

Mu=Muf 
Rectangular_Section_Design 
Footing_MinSteel 

minss AA <  

minss AA =  

Yes

D
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Figure 3.43 continued 

D

FootingAstB(SL1)=As*LT 
FootingLength(SL1)=LT 
FootingWidth(SL1)=BT 
FootingHeight(SL1)=HT 
FootingEdepthWide(SL1)=Df_Wide 
FootingEdepthPunching(SL1)=Df_Punching 
AstShort=FootingAstB(SL1) 
Beta=FootingLength(SL1)/FootingWidth(SL1) 
FootingAstBC(SL1)=AstCentral 
FootingAstBS(SL1)=AstOutside 
BarArea=3.1416*FootingBarDiameter(SL1)2/400 
FootingBarsL(SL1)=FootingAstL(SL1)/BarArea >= 2 
FootingBarsBC(SL1)=FootingAstBC(SL1)/BarArea 
FootingBarsBS(SL1)=FootingAstBS(SL1)/BarArea 
FootingBarsB(SL1)=FootingAstB(SL1)/BarArea  >= 2 

End
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3.11 The Display Menu: 

This menu is used to display input data. 

3.11.1 The Show Sections Submenu: 

This submenu display the Show Design Sections or Show Analysis 

Sections dialog as shown in Figure 3.44 (form name: 

ShowDesignSections, file: ShowSections).  

Figure 3.44 Show Design Sections dialog 

3.11.2 The Show Input Section Forces Submenu: 

This submenu is used to display the design forces in the Show Design 

Forces dialog as shown in Figure 3.45 (form name: ShowDesignForces, 

file: ShowForces).  

Figure 3.45 Show Design Forces dialog 

 

 

3.11.3 The Show Input Sections Reinforcement Submenu 
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This submenu is used to display the reinforcement data of elements for 

analysis as shown in Figure 3.46 (form name: ShowAnReinforcement, 

file: ShowAnRei.frm).  

 

Figure 3.46 Show reinforcement dialog 

 

Figure 3.47 shows the section shear reinforcement (form name: 

ShowShearReinforcement, file: ShowShear.frm) and Figure 3.48 shows 

the Show Footing Dimensions and Reinforcement dialog (form name: 

ShowFootingData, file: Check.frm).  

Figure 3.47 Show Section Shear Reinforcement dialog 
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Figure 3.48 Show Footing Dimensions and Reinforcement dialog 

 

3.12 The Options Menu: 

This menu is used to display analysis and design options. 

3.12.1 The Preferences Submenu: 

This submenu displays the Preferences dialog as shown in Figure 3.49 

(form name: Preferences, file: Preferences).  

Figure 3.49 Preferences dialog 

The variables that are read from this dialog are defined as follows: 

PhiMoment = the strength reduction factor for bending moment. The 

default value is 0.9 
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PhiTension = the strength reduction factor for pure tension. The default 

value is 0.9 

PhiCompression = the strength reduction factor for compression of 

rectangular column section. The default value is 0.7 

PhiShear = the strength reduction factor for shear. The default value is 

0.85 

PhiTorsion = the strength reduction factor for torsion. The default value is 

0.85 

ColRmin = minimum steel ratio in column section. The default value is 

0.01 

ColRmax = maximum steel ratio in column section. The default value is 

0.08 

ColReduction = strength reduction factor for column minimum 

eccentricity. The default value is 0.8 

FotTmin = minimum depth of footing 

3.13 The Help Menu: 

The program is supported by Arabic and English help files. The help 

subject can be displayed by pressing the F1 key. A sample is shown in 

Figure 3.50. 

Figure 3.50a A sample of English help 
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Figure 3.50b A sample of Arabic help 
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Chapter Two 
Theory of Analysis and Design of Reinforced Concrete 

Sections 

2.1 Introduction 

This chapter will illustrate the theoretical basic principles for analysis and 

design of reinforced concrete sections according to ACI318-99. Also, these 

theoretical steps will be illustrated in flowcharts that will be transformed to 

subroutines in the program source code.  

2.2 Analysis and Design of Reinforced Concrete Sections for Flexure: 

In this section, the principles of analysis and design of reinforced concrete 

sections using the ultimate strength method will be shown. In analysis, the 

beam section dimensions, material properties and reinforcement are given 

and the moment capacity will be calculated. The section dimensions are the 

section width b and the section height h. The material properties are the 

concrete cylinder compressive strength at 28 days fc’,  the steel yield 

strength fy and the shear steel yield strength fys. The reinforcement 

quantities are the area of tension steel As and the area of compression steel 

As’. In design, the trial beam section dimensions, material properties and 

bending moments are given and the required reinforcement will be 

calculated.  

Sections 2.2.1 and 2.2.2 will cover the analysis of rectangular reinforced 

concrete sections for singly and doubly reinforcement respectively. Section 

2.2.3 will cover the design principles of rectangular beam. Section 2.2.4 

will cover the analysis of T and L beam sections. Section 2.2.5 will cover 

the design of flanged beam section.  
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2.2.1 Analysis of Singly Reinforced Rectangular Beam Section for 

Flexure:  

A singly reinforced section is a section that has tension steel only (it has no 

compression steel) as shown in Figure 2.1. The depth of the compression 

block, a is given by: 

 

The design moment of the beam section, Md will be given by: 

where 

Ф=strength reduction factor for flexure which equals to 0.9 

                     (a)                                      (b)                              (c)                           (d)  
Figure 2.1 Stress and strain distribution across beam section: (a) beam 
cross-section; (b) strains; (c) actual stress block; (d) assumed equivalent 
stress block 

 

The steel ratio, ρ is given by: 

d
h

b

As

Tension
side

Cs

side
Compression

C

Neutral axis
(d-a/2)

T=As fs T

0.85fc

a=BCC

0.85fc

a/2

C

Cc= 0.003

(2.1)                                                                      
'85.0 bf

fA
a

c

ys=

(2.2)                                                   )
2

('85.0 adbafM cd −= φ
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This steel ratio should be larger than a minimum value specified by the 

code. The code states the minimum area of steel as (b is the width of the 

web of the section): 

Also, the tension steel ratio should be less than a maximum value: 

Where ρb is the steel ratio at the balanced condition. The balanced 

condition in a beam section in flexure is achieved when the steel starts 

yielding at the same time when the concrete just reaches its ultimate strain 

capacity and commences to crush.  ρb is given by: 

 

 

Where β1 is a factor depends on the concrete compressive strength that is 

given by: 

 

 

The previous equations for calculating the minimum steel ratio, β1 and the 

maximum steel ratio are shown in the flowcharts in Figures 2.2, 2.3 and 2.4 
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respectively. These flowcharts are transformed to the subroutines 

Rho_Min, Beta_1 and RhoMax_Rectangle.  
 

 

 

 

 

 

 

 

 

Figure 2.2 Flowchart to calculate ρmin , subroutine Rho_Min 
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Figure 2.3 Flowchart to find the value of β1, subroutine Beta_1 

Figure 2.4 Flowchart to calculate ρmax, subroutine RhoMax_Rectangle 

Start 

2
1 /in  ' ,

70
280'05.085.0 cmkgff

c
c ⎟

⎠
⎞

⎜
⎝
⎛ −

−=β  

65.01 =β 85.01 >β  

85.01 =β  

End 

Yes 

Start 

b
yy

c
b ff

f
ρρ

β
ρ 75.0    ,

)6120(
6120'85.0

max
1 =
+

=  

End 



  13

2.2.2 Analysis of Doubly Reinforced Rectangular Beam Section for 

Flexure:  

Doubly reinforced concrete sections contain reinforcement both at tension 

and at compression faces or at top and bottom of section as shown in 

Figure 2.5. Compression steel becomes necessary when the dimensions of 

the section are restricted due to architectural limitations.  

Figure 2.5 Doubly reinforced beam section: (a) cross-section; (b) strains; 
(c) part 1, singly reinforced part; (d) part 2, contribution of compression 
steel 

 

In analysis and design of beam sections with compression and tension 

reinforcement, the analysis is so divided into two parts: (1) the singly 

reinforced part involving the equivalent rectangular block as discussed 

before with the area of tension reinforcement being (As1= As-As’); and (2) 

the two areas of equivalent steel As2= As’ at both the tension and 

compression sides to form a couple. The bending moment, Md that is 

formed from the two parts is given by: 

 

d

As

Cs

C

0.85fc

a=BC
a/2

C1

b

N.A

As1

As'

(d-d')

d' Cs'

C2
As'

(a) (b) (c) (d)

Cc= 0.003

As2
T2T1

(d-a/2)
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Where a is given by: 

Where fs is the stress in the compression steel that is given by: 

 

 

Where ρ’ is the ratio of the compression steel. It is always necessary to 

verify that the strains across the depth of the section follow the linear 

distribution shown in Figure 2.5. In other words, a check is necessary to 

ensure that strains are compatible across the depth at the strength design 

levels. Such verification is called a strain-compatibility check. The 

compression steel yield if: 

 

The tension steel ratio, ρ should be less than the maximum that is: 

 

 

The previous procedure and equations are shown in the flowchart in Figure 

2.6 that illustrates a complete procedure for analysis of beam section. This 

flowchart is transformed to the subroutine Rectangular_Beam_ Analysis. 
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Figure 2.6 Flowchart for analysis of rectangular beam section for 
flexure, subroutine Rectangular_Beam_Analysis
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Figure 2.6 continued 
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2.2.3 Design of Rectangular Beam Section for Flexure: 

In designing for a factored negative or positive bending moment, Mu (i.e. 

designing top or bottom steel) the depth of the compression block is given 

by a in cm where, 

 

where Mu is in ton-meter, d and b in cm and  f’c in kg/cm2 . The maximum 

allowed depth of the compression block is given by 
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Figure 2.6 comtinued 
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The procedure for calculating β1 was mentioned before. The depth to 

neutral axis cb at the balanced condition is given by 

 

 

If  a ≤ amax, the area of tensile steel reinforcement  As in cm2 is given by 

 

This steel is to be placed at the bottom if Mu is positive, or at the top if Mu 

is negative. 

If a > amax, compression reinforcement is required and is calculated as 

follows: 

 

1. The compressive force developed in concrete alone is given by 

 

and the moment resisted by concrete compression and tensile steel is  

 

2. The moment resisted by compression steel and tensile steel is 

 

3. The required compression steel is given by  
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where  

 

4. The required tensile steel for balancing the compression in concrete 

is 

 

The tensile steel for balancing the compression in steel is given by 

 

5. The total tensile reinforcement, As=As1+As2, and the total 

compression reinforcement is As’. As is to be placed at bottom and 

As’ is to be placed at top if Mu is positive, and vice versa if Mu is 

negative. 

The provided tensile steel should be larger than the minimum given in Eq. 

2.4 or 4/3 the calculated tensile steel area. 

The above steps are summarized in the flowcharts in Figures 2.7, 

2.8,  2.9 and 2.10. These flowcharts are transformed to subroutines 
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Compression_Block_Depth, Rectangular_Beam_Design, Steel_Area and 

Rectangular_Section_Design respectively. 
 

 

 

 

 

 

 

 

 

 

Figure 2.7 Flowchart to calculate a and amax, subroutine 
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Figure 2.8 Flowchart to calculate As in rectangular section, subroutine 
Rectangular_Beam_Design
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2.2.4 Analysis of T and L Beam Sections for Flexure: 

The basic principles used for analysis and design of rectangular beams are 

also valid for the flanged beams. The major difference between the 

rectangular and the flanged sections is in the calculation of the compressive 

force Cc. Depending on the depth of the neutral axis, C, the following cases 

can be identified: 

Figure 2.9 Flowchart to set final value of As, subroutine Steel_Area 

Figure 2.10 Flowchart to design rectangular section for bending,  
subroutine Rectangular_Section_Design 

Start

Subroutines: 
Compression_Block_Depth 
Rectangular_Beam_Design 
Steel_Area 

End
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Case 1: depth of neutral axis, C is less than flanged thickness hf (Figure 

2.11): 

This case can be treated similarly to the standard rectangular section 

provided that the depth a of the equivalent rectangular block is less than the 

flange thickness. The flange width bf of the compression side should be 

used as the beam width in the analysis. Equations  2.1 and 2.2    are 

applied.  

Case 2: Depth of neutral axis is larger than flange thickness hf (Figure 

2.12): 

In this case if the depth of the equivalent rectangular stress block, a is 

larger than the flange thickness, thus the section is considered as a flanged 

section. This section could be treated in the same manner as for a doubly 

reinforced rectangular section. The contribution of the flange overhang 

compressive force is considered analogous to the contribution of imaginary 

compression reinforcement, this compressive force, C' is equal to the 

average concrete strength fc’ multiplied by the cross-sectional area of the 

flange overhangs. Thus C' is given by: 
 

 

(2.24)                              )('85.0' ffc hbbfC −=
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Figure 2.11 T-beam section with neutral axis within the flange (a<hf): (a) 
cross section; (b) strains; (c) stresses 
 

 

 

Figure 2.12 Stress and strain in flanged section: (a) cross-section; (b) 

strains; (c) transformed section; (d) part 1 forces; (e) part 2 forces  
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For a beam section to be considered as a real T-beam, the tension force Asfy 

generated by the steel should be greater than the compression force 

capacity of the total flange area 0.85fc’bhf. Hence 

 

The percentage for the balanced condition in a T-beam section can be 

written as 

 

where  

 

The reinforcement ratio for tension steel area necessary to develop the 

compressive strength of the overhanging flanges, ρf is given by: 

 

 

To satisfy the requirement of minimum reinforcement, for positive 

moment, the web reinforcement should not have steel less than given in 

Equation 2.4.  

As in the case of analysis and design of doubly reinforced sections, the 

reinforcement at tension side is considered to be composed of two areas: 
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As1 to balance the rectangular block compressive force on area ba, and As2 

to balance the imaginary steel area Asf. Consequently, the total design 

moment strength for parts 1 and 2 of the solution is 

 

If having compression steel in the flange, modifications should be made as 

follows: 

� The stress in compression steel will be found using the same 

procedure used for analysis of doubly reinforced rectangular section 

� The depth of the compression block in concrete, a will be given by: 

   

� If a is less than flange thickness hf, the section should be analyzed as 

doubly reinforced rectangular section with width of bf.  

� If a is larger than hf, a will be given by 

 

In this case the design bending Md will be calculated as 

 

where  
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Mn1= is the nominal moment developed by the tension steel balancing the 

concrete compressive strength in the web 

Mn2= is the nominal moment developed by the force in tension steel and the 

force capacity of the overhangs 

Mn3= is the nominal moment developed by the forces in the tension and the 

compression steel as a couple force multiplied by the arm d-d’. 

The design moment, Md equals the nominal moment Mn multiplied 

by the strength reduction factor for flexure Φ = 0.9. 

Figure 2.13 illustrates flowchart shows the procedure followed in analysis 

of flanged beam section for flexure. The maximum steel ratio calculations 

are illustrated in the flowchart shown in Figure 2.14. These flowcharts are 

transformed to the subroutines Flanged_Beam_analysis and 

RhoMax_FlangedSection respectively. 

 

 

Figure 2.13 Flowchart for analysis of flanged beam, 
subroutine Flanged_Beam_Analysis
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Figure 2.13 continued 
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Figure 2.13 continued 
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Figure 2.13 continued 
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2.2.5 Design of Flanged Beam Section for Flexure: 

In designing for a factored negative moment, the calculation of the steel 

area is exactly as rectangular beam section, no flanged beam section data is 

to be used. For the positive moment, the depth of the compression block is 

given by( Mu in ton.m, a,d and bf in cm and fc’ in kg/cm2): 

 

The maximum allowed depth of compression block is given by  

 

 

Figure 2.14 Flowchart to calculate maximum steel ration in flanged 
section, subroutine RhoMax_FlangedSection 
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If a ≤ hf, the subsequent calculations for As are exactly the same as 

previously defined for the rectangular section design. However, in case the 

width of the compression flange is taken as the width of the beam. Whether 

compression reinforcement is required depends on whether a > amax. 

If a > hf, calculation for As is done in two parts. The first part is for 

balancing the compressive force from the flange, Cf, and the second is for 

balancing the compressive force from the web, Cw. Cf is given by 

Therefor, As1 = Cf/fy and the portion of Mu that is resisted by the flange is 

given by 

The value of Φ is 0.9. Therefore, the balanced of the moment, Mu to be 

carried by the web is given by 

The web is a rectangular section with dimensions b and d, for which the 

design depth of the compression block is recalculated as 
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If a1 > amax, compression reinforcement is required and is calculated as 

follows: 

# The compressive force in web concrete alone is given by 

 

# Therefore the moment resisted by concrete web and tensile steel is 

 

the moment resisted by compression steel and tensile steel is 

 

# The compression steel is computed as 

 

 

# The tensile steel for balancing the compression in web concrete is 
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# The total tensile reinforcement, As= As1+As2+As3, and the total 

compression reinforcement is As’. As is to be placed at bottom and As’ is to 

be placed at top. 

The above procedure is shown in the flowchart in Figure 2.15. This 

flowchart is transformed to the subroutine Flanged_Beam_Design. 
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Figure 2.15 Flowchart for design of flanged section for 
bending moment, subroutine Flanged_Beam_Design 
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2.3 Analysis and Design for Shear and Torsion: 

The shear reinforcement is designed in the major direction of the beam 

section (parallel to the direction of the load that causes deflection to the 

beam element),  and in the major and minor directions of the column 

section (in both directions of column section). The beam in this program is 

designed for uniaxial bending moment, major direction shear and torsion. 

The axial force, Pu on the section affects the shear capacity of the section. 

The axial load applied on the beam is restricted to 0.1 fc’ Ag (Ag: gross 

section area). 

The main steps in the design of a beam or a column section for shear are as 

follows: 

1. Determine the shear force capacity, Vc that can be resisted by the 

concrete alone. The applied axial force affects this value. 

2. Calculate the reinforcement steel required to carry the applied shear 

force considering vertical stirrups only.  

2.3.1 Determining Concrete Shear Capacity: 

Given the design forces Pu and Vu, the shear force carried by the concrete, 

Vc, is calculated as follows: 

1. If the section is subjected to axial compression (Pu is positive): 

where  

Ag = gross section of the member in cm2 

fc’ = concrete compressive strength in kg/cm2 
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Pu = applied axial force in kg 

Ac = area of concrete used to determine shear stress in cm2 

Vc = shear force resisted by concrete in kg 

and  

 

2. If  the section is subjected to axial tension (Pu is negative): 

The procedure of calculating Vc is shown in the flowchart in Figure 2.16. 

This flowchart is transformed to the subroutine Concrete_Shear_Capacity. 

2.3.2 Determining Required Shear Reinforcement: 

Given Vu and Vc, the nominal shear force is given by 

Where Φ = 0.85 for shear design. Then the nominal shear force, Vn is 

compared with section shear capacity, Vc as follows: 

� if Vn ≤ Vc/2, no shear reinforcement is required 

� if Vc ≥  Vn > Vc/2,  minimum shear reinforcement should be used 

except in the following cases: 
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1. Slabs and footings 

2. Concrete joist construction 

3. Beams with total depth not greater than 25 cm, 2.5 times 

thickness of flange, or ½ the width of web, which is the greatest. 

The minimum shear reinforcement Av/s is given by: 

 

Where Av is the area of stirrup legs in a section. 

Figure 2.16 Flowchart for calculating, Vc, subroutine 
Concrete_Shear_Capacity 
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� if Vn > Vc, the shear value that will be resisted by shear 

reinforcement, Vs will be: 

 Otherwise, the section is not adequate and it needs enlargement. 

The shear reinforcement Av/s will be given as 

The stirrups spacing are limited to 

The procedure for finding the maximum stirrups spacing of shear 

reinforcement is illustrated in the flowchart in Figure 2.17 

2.3.3 Section Analysis for Shear: 

The program calculates the design shear force for a given section 

dimensions and shear reinforcement. The shear force resisted by the shear 

reinforcement is given by 

The stirrups spacing defined in Equation 2.52 limits the shear resisted by 

shear reinforcement, Vs. Then the design shear capacity is given by 
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Figure 2.17 Flowchart to find shear Smax, flowchart 
Shear_Maximum_Spacing  
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The concrete shear capacity is affected by applied axial force on the 

section. The program introduces a diagram that relates the axial load and 

the shear capacity of the section in both directions of column section and in 
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the major direction of a beam section. The analysis steps for shear force 

capacity of a section for a given reinforcement are illustrated in the 

flowcharts in Figures 2.18 to 2.22. These flowcharts are transformed to the 

subroutines ShearReinforcement_Capacity_Vs, Shear_VsMax, 

Shear_AvOverS_AtOverS , Section-Design_Shear_Capacity and 

Shear_Vn_Vs respectively. 

2.3.4 Design for Shear and Torsion: 

The ultimate torsion, Tu on a section is the value of torsion at distance d 

from face of support. The applied shear and torsion forces made surface 

stresses on the section. The shear force, Vu is resisted usually by the 

vertical legs of the stirrups in a beam section or ties or spirals in a column 

section. The torsion force is usually resisted by stirrups or ties in addition 

to longitudinal reinforcement along the member especially at the corners. 

The design steps for combined shear and torsion are as follows: 

1. Calculate the section torsional moment capacity, Tuc. If the 

applied torsion Tu is less than the section torsional moment capacity, the 

torsional moment is neglected and the design will be performed for 

shear only. Tuc is given by: 

 

 

Figure 2.18 Flowchart to compute capacity of shear 
reinforcement, subroutine ShearReinforcement_Capacity_Vs 
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Figure 2.20 Flowchart to compute Av/s and At/s variables, 
subroutine Shear_AvOverS_AtOverS 

Figure 2.19 Flowchart to compute maximum allowed shear 
capacity of reinforcement, subroutine Shear_Vsmax 
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Figure 2.21 Flowchart to calculate shear capacity for given shear 
reinforcement, subroutine Section_Design_Shear_Capacity 
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where 

Acp = area enclosed by outside perimeter of concrete cross section 

Pcp = outside perimeter of concrete cross section 

2. Check section adequacy. The section should satisfy the following 

equation: 

Figure 2.21 continued 

Figure 2.22 Flowchart to calculate Vn and Vd, 
subroutine Shear_Vn_Vs 
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If not, the section should be enlarged.  

where   

Vu = the applied shear force in kg 

Tu = the applied torsional moment in kg.cm 

b = section web width in cm 

d = section effective depth in cm 

fc’ = concrete compressive strength in kg/cm2 

Aoh = area enclosed by the centerline of the outmost closed transverse 

torsional reinforcement; stirrups in cm2 

Ph = perimeter of centerline of outmost closed transverse torsional 

reinforcement; stirrups in cm. 

Vc = concrete compressive strength, this value is affected by the applied 

axial force 

Ф = strength reduction factor for shear which equals 0.85 

3. Calculate the required torsional transverse reinforcement such that 

where 

At = area of one leg of the torsional transverse reinforcement; stirrups in 

cm2 

s = torsional transverse reinforcement spacing in cm 

Tn = nominal applied torsional moment in kg.cm 

fys = yield strength of torsional transverse reinforcement in kg/cm2 
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Ao = gross area enclosed by the shear flow, which equals in a rectangular 

section to 0.85Aoh in cm2 

4. Calculate the required shear reinforcement Av/s as discussed in previuos 

sections.   

If not enlarge section. 

 

 

5. Calculate total transverse reinforcement as the sum of the torsional 

transverse reinforcement and the shear transverse reinforcement as follows 

 

Then s is found by dividing the area assuming two legs of the stirrup by 

Avt/s. The maximum allowable spacing of stirrups, s is the smaller of Ph/8 

and 30cm. Also, the requirements for maximum spacing for shear alone 

should be satisfied. Avt/s should be larger than 3.5b/fy. 

6. Calculate the required torsional longitudinal reinforcement Al, and Al 

should be larger than a minimum value Almin as follows: 
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7. Arrange the longitudinal reinforcement such as at least one bar should be 

placed at each corner of the stirrup. The spacing between the longitudinal 

bars should not be larger than 30cm.  The program calculates the required 

longitudinal reinforcement for the applied torsion. This steel is added to the 

required flexural steel. The torsional longitudinal reinforcement will be 

distributed as follows: one forth the area of steel is placed at top of section, 

one half of the area is placed at middle of the section and one forth of the 

area is placed at bottom of the section.   

The previous steps of shear and torsion design are translated to flowcharts 

in Figures 2.23 to 2.30. These flowcharts are transformed to the subroutines 

Shear_Vs_ForDesign, Shear_Design1, Torsion_Section_properties, 

Torsion_ Tmin, Torsion_Shear_Section_Adequecy, 

Torsion_Stirrups_MaximumSpacing, Torsion_LongitudinalSteel, and 

Shear_Torsion_Design respectively.  

 
 

 

Figure 2.23 Flowchart to calculate Vs for shear design, 
subroutine Shear_Vs_ForDesign
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Figure 2.24 Flowchart for design of shear force, 
subroutine Shear_Design1 
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Figure 2.25 Flowchart to calculate section properties for 
torsion computations, subroutine Torsion_Section_Properties 
 
Figure 2.26 Flowchart to calculate Tmin, subroutine Torsion_Tmin 

 

Figure 2.27 Flowchart to check section adequacy for torsion, 
subroutine Torsion_Shear_Section_Adequacy 
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Figure 2.28 Flowchart to find the maximum allowed spacing of 
stirrups for torsion, subroutine Torsion_Stirrups_MaximumSpacing 
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Figure 2.29 Flowchart to calculate the longitudinal steel for torsion, 
subroutine Torsion_LongitudinalSteel 

Figure 2.30 Flowchart for shear and torsion design, subroutine 
Shear_Torsion_Design 

 

Start

φ/un TT =  
Torsion_Section_Properties 
Torsion_Tmin 

minTTu ≤

Check_Minimum_Torsion=1 
Check_Enlarge_Section_Torsion=0 
Concrete_Shear_Capacity 
Shear_Vs_ForDesign 
Shear_Maximum_Spacing 
Shear_Design1 

0,0,0/ min === llt AAsA  

Check_Minimum_Torsion=0 
Concrete_Shear_Capacity 
Torsion_Shear_Section_Adequacy 

BA σσ >
Yes

Yes

Check_Enlarge_Section_Torsion=0 

cnsun

ysont

VVVVV

fATsA

−==

=

,/

)2/(/

φ
 

Shear_Maximum_spacing 

Check_Shear_EnlargeSection
=1

A B  

B B  

Yes 



  54

 
 
 

 
 
 

 
 
 
 
 

Figure 2.30 continued 
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2.4 Analysis and Design of Rectangular Column Section for Combined 

Bending and Axial Forces: 

In column analysis, the user specifies the reinforcement configuration; bars 

locations and areas. The program gives the bending-axial interaction 

diagram in each direction of the column section.  

In column design, the user specifies the applied forces and reinforcement 

locations or one bar diameter for the given section dimensions. The 

program gives the required area of steel for the given reinforcement 

location or the reinforcement location for the given bar area. Also, the 

program gives the bending-axial interaction diagram in each direction of 

column section.  

The major steps in the design of a column section for combined bending 

and axial load are: 

1. Determine the moment magnification factors for the given bending 

moments in each direction depending on the type of column; sway or 

non-sway and the column length and so the final design moments.  

2. Introduce a reinforcement bar configuration and then analyze the 

section. The column section capacity factor (the ratio of the applied 

column loads to the column capacity) for biaxial bending and axial load 

is calculated. This factor is calculated according to the contour method, 

and this factor should be less than one. The reinforcement area is 

increased from a minimum ratio to a maximum ratio, which are 

specified by the user, for a specified bar location. This operation is 

repeated until the section capacity factor becomes less than one.  

3. Calculating points of bending-axial interaction diagram. 
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The major step in column section analysis is calculating points of the 

interaction diagram. 

2.4.1 Section Analysis: 

The same principles concerning the stress distribution and the equivalent 

rectangular stress block applied to beams will be used for column section 

analysis. Figure 2.31 shows a typical rectangular column cross-section with 

stress, strain and force distribution. The depth of the neutral axis, C 

determines the strength of the column. From Figure 2.31, the nominal axial 

resisting force Pn at failure is: 

The nominal bending moment is given by: 

 

Figure 2.31 Stress and strain distribution in column section 
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This procedure of calculating Pn and Mn is repeated for each row of 

reinforcement bars using the value of the neutral axis depth, C. Figure 2.32 

shows the flowchart for calculating Pn and Mn for rows of reinforcement. 

 

 

Figure 2.32 Flowchart to calculate force and moment developed in 
rows of reinforcement, subroutine ReinforcementRow_Force_Moment 
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Figure 2.32 continued 
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2.4.2 Uniaxial Bending Moment-Axial Force Interaction Diagram: 

 The maximum nominal axial load capacity of column section is given by: 
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Where Ψ is a reduction factor for considering minimum eccentricity and 

equals 0.8. The maximum design axial load is given by: 

 

 

The value of Φ used in the interaction diagram varies from strength 

reduction factor for compression to strength reduction factor for flexure. 

The default values are 0.7 and 0.9 respectively. This variation is based on 

the axial load. For low values of axial loads, Φ is increased linearly from 

0.7 to 0.9 as the axial load decreases from the smaller of Pb or 0.1fc’Ag to 

zero, where Pb is the axial force at the balanced condition. In cases 

involving axial tension, Φ is always 0.9. Figure 2.33 shows a flowchart for 

calculation of Pnb and Mnb and Figure 2.34 shows a flowchart illustrating 

the steps of computing the strength reduction factor Φ when ΦPn is smaller 

than the smaller of 0.1fc’Ag and ΦPnb. 

To draw the moment-axial loads interaction diagram, the points of P and M 

are calculated for different values of rectangular compressive block, c. The 

major points of the interaction diagram are: 

 

 

 

Figure 2.33 Flowchart to calculate the force and the moment at the 
balanced condition, subroutine Column_Balanced_Condition 
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Figure 2.34 Flowchart to calculate Ф subroutine Phi_Column 

Figure 2.34 continued 
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1.  Pure maximum axial load: as indicated in Equations 2.66 and 2.67 

2. Points at the balanced condition: the values of the balanced axial force 

and bending moment are computed at a value of cb as shown by the 

flowchart in Figure 2.33. 

3.  Points at axial load equals 0.1fc’Ag 

4. Pure maximum bending moment at zero axial load 

5. Pure tension capacity at zero moment: the tension capacity is given 

by: 

The previous discussion is translated to flowcharts that are transformed to 

computer subroutines. The flowcharts show the steps of calculating the 

points of the interaction diagram and computations dealing with the bars 

arrangement in the column section. These flowcharts are introduced in 

Figures 2.43 to 2.55. 

2.4.3 Moment Magnification: 

The moment magnification factors are calculated separately for sway, δs 

and for non-sway, δns. Also, the moment magnification factors are 

calculated in both directions depending whether the column is in a sway or 

non-sway frame.  
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2.4.3.1 Non-sway Columns: 

The slenderness effects are disregarded if 

 

Where 

k = equivalent effective length factor 

lu = unbraced column length 

r = radius of gyration which equals the square root of the moment of inertia 

divided by the gross area of the section.  

M1 = the smaller non sway end moment at column ends 

M2 = the larger non sway end moment at column ends 

M1/M2 is positive for single curvature bent and is negative for double 

curvature bent. 

The moment to be designed will be (Mu=M2) 
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Pc = the critical Euler buckling load for pin-ended columns 

Pu = applied factored axial compression 

Ie = section effective moment of inertia in the direction of M2 

Ig = section gross moment of inertia in the direction of M2 

E = modulus of elasticity of concrete and it is equal to 

 

In equation 2.72, E and f'c are in kg/cm2.  

βd = maximum factored sustained axial load divided by the total factored 

axial load 

Cm = a factor relating the actual moment diagram to an equivalent uniform 

diagram.  

The minimum allowed value of M2 is 
 

 

Where, h is the side length of the column section in the direction of 

bending in meter.  

In equation 2.71d, if M1 is zero, Cm will be 0.6. If M1 and M2 are zeros, Cm 

will be 1.0. 

The above expression of Cm is valid if there is no transverse load applied 

between the supports. If transverse load is present on the span, Cm will be 

one.  
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The magnification factor, δns, must be positive number and greater than 

one. Therefore, Pu must be less than 0.75Pc. If Pu is found to be greater than 

or equal to 0.75Pc, a failure condition is declared. 

2.4.3.2 Sway Columns: 

For compression members in sway frames, the slenderness effects are 

neglected if 

The end moments M1 and M2 are magnified as follows with the non-sway 

moments unmagnified, provided that   

On the assumption that M2 > M1, the design moment, Mc  is 

Where 

M1s = smaller sway end moment (from earthquake, wind and other forces) 

M2s = larger sway end moment (from earthquake, wind and other forces) 

M1ns = smaller non-sway end moment (from dead and live forces) 

M2ns = larger non-sway end moment (from dead and live forces)  

The sway moment magnification factor, δs is given by 
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Where, 

ΣPu = the summation for all vertical loads in a story  

ΣPc = the summation of the Euler buckling loads, Pc, for pin-ended 

columns for  all sway resisting columns in a story considering βd  as the 

ratio of the maximum factored sustained shear within a story to the factored 

shear in that story which is usually equals to zero except for lateral earth 

pressure. The user of the program enters the value of δs. 

In cases where  

The design moment will be the maximum of : 

 

The moment magnification method is developed for prismatic members 

with klu/r not exceeding 100.  

The previous equations for calculating Cm, δns, Pcr, kl/r checks, and the 

design moment Mc are shown in the flowcharts in Figure 2.35 to 2.42. 

These flowcharts are transformed to subroutines Column_Cm, 

Column_Pcr, Column_Rg, Column_KLRfactor, Column_CheckKLRfactor, 

Column_DeltaNs, Column_DeltaNs1 and Column_Mc. 

Figure 2.35 Flowchart to calculate Cm, subroutine Column_Cm 
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Figure 2.36 Flowchart to calculate Pcr, subroutine Column_Pcr 

Figure 2.37 Flowchart to calculate radius of gyration,r, subroutine 
Column_Rg
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Figure 3.38 Flowchart to calculate Klu/r, subroutine 
Column_KLRfactor 
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Figure 2.39 Flowchart for checking kl/r for sway and nonsway 
columns, subroutine Column_CheckKLRfactor
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Figure 2.41 Flowchart to determine final value of δns, subroutine 
Column_DeltaNs1 

Figure 2.40 Flowchart to calculate  δns, subroutine Column_DelatNs 
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Figure 2.42 Flowchart to calculate the design moment at a point, Mu, 
subroutine Column_Mu 
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2.4.4 Load Contour Method: 

There are many methods for determining the capacity or designing the 

column section for biaxial bending. The contour method is the simplest one 

and can be programmed practically. In this method, the bending moment 

capacities Mox and Moy are calculated at the given axial load. And then the 

following equation is applied: 

  

Where: 

Mnx, Mny = applied ultimate bending moments about the x and y axes. 

Mox, Moy = ultimate bending moment capacities about the x and y axes at 

the given nominal axial load, Pu. These values are found using the general 

case in Figure 2.19 for a trial value of c.  

α = exponent depending on the cross section geometry, steel percentage, 

and its location and material strengths fc’ and fy. The value of  α is given 

by: 

 

There are charts that relates the value of β to reinforcement configuration, 

fc’, fy, axial load and steel ratio found in some references. These charts do 

not have specified equations as they were derived from experimental 

studies. From these charts, the value of β ranges from 0.52 to 0.9. 

Predominantly, the value of β ranges up to 0.65. The corresponding values 

of α ranges from 1.05 to 1.6. For design, it is recommended to use a value 

(2.79)                                          0.1=⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛
+⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
αα

oy

ny

ox

nx

M
M

M
M

(2.80)                                                          
)log(
)5.0log(

β
α =



  72

of α equals to 1.5 for rectangular sections (reference 5 page 513). Equation 

2.80 is used for a value of α = 1.5 or β = 0.63 in this program. For given 

bending moments and axial load and for a reinforcement configuration, 

equation 80 is applied. If the section capacity ratio (value of equation 2.79) 

is greater than 1, an increasing value of bars areas is indicated until the 

section capacity ratio reaches the value of 1.0 or less.  

2.4.5 Column Design Shear Force: 

 The shear reinforcement is designed for each loading in the two 

dimensions of column. The column is located in an ordinary, intermediate 

or special moment resisting frame. The design shear force is calculated as 

follows: 

� In the design of shear reinforcement of an ordinary moment resisting 

frame (no seismic considerations), the design shear force is found as it is 

given or calculated from load combination. 

� In the shear design of Special moment resisting frame (seismic 

design), the design shear force is the maximum of the calculated shear 

force from load combination or the value of Vp calculated from  the 

moment capacities of the section: 

Where Mpr1 and Mpr2 are the probable moment strength at the ends of the 

column based on steel reinforcement tensile strength of 1.25fy and strength 

reduction factor of one at the given ultimate axial load, Pu and h is the clear 

height of column. Equation 2.81 is used, as the column does not have 

transverse loading as the usual case of column condition.  
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� For intermediate moment resisting frames (seismic design), the 

design shear force is the minimum of the calculated shear force with the 

earthquake load factors is doubled and Vp in Equation 2.81 but using 

steel tensile strength of fy.  
 

 

Figure 2.43 Flowchart to calculate the column section axial capacity, 
subroutine Ultimate_Axial_Capacity 

Figure 2.44 Flowchart to calculate the column tension capacity, 
subroutine Tension_AxialCapacity 

Figure 4.45 Flowchart to calculate the value 0.1fcAg, 
subroutine Column_Pmin 
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Figure 2.46 Flowchart to calculate pure bending moment capacity, 
subroutine Column_Pure_Moment 
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Figure 2.47 Flowchart to calculate bending moment capacity at 
asxial force equals 0.1fc’Ag, subroutine 
Column_Moment_OnetenthFcAg
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Figure 2.48 Flowchart to calculate bending moment capacity at 
axial force equals 0.8 the maximum axial capacity, subroutine 
Column_Moment_EightyPercent
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Figure 2.49 Flowchart to find column P_M interaction points (2 points) 
at axial loads between 0.8 the compression maximum axial capacity and 
the balanced axial capacity, subroutine 
InteractionPoints_BalEightyPercent

Figure 2.50 Flowchart to calculate the biaxial factor, 
subroutine Column_Biaxial_Factor 
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Figure 2.51 Flowchart to calculate bending moment capacity at a 
given axial force, subroutine Column_Mo 
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Figure 2.52 Flowchart for construction of axial force_bending 
moment interaction diagram, subroutine 
Column_PM_Diagram 

Figure 2.53 Flowchart to determine minimum bars in column 
section, subroutine Column_MinBars 
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Figure 2.54 Flowchart to calculate total no. of bars and total steel 
area for given bars arrangement, subroutine 
Column_BarsNo_AstTotal

Figure 2.55 Flowchart to find As and d for reinforcement rows, 
subroutine Column_Reinforcement_Area_Depth
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Figure 2.55 continued 

Figure 2.56 Flowchart to calculate the no. of bars and bar area for 
given bars arrangement for a steel ratio, subroutine 
Column_Design_Given_BarsArrangement
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Figure 2.57 Flowchart to calculate BarsH and BarsB from given 
bar diameter for a steel ratio, subroutine 
Column_Design_Given_BarDiam
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2.5 Analysis and Design of Single Footing 

The program has the ability of analysis and design of single footing. In 

analysis the user specifies the footing dimensions and reinforcement and 

the program gives the footing design axial load. In design, the user 

specifies the ultimate load and the program gives the footing dimensions 

and reinforcement.  

2.5.1 Single Footing Analysis: 

The major steps of footing analysis are: 

1. Compute the resisting force by the soil bearing capacity. 

2. Compute the resisting force by reinforced concrete flexural strength. 

3. Compute the resisting force by reinforced concrete shear strength. 

4. Compute the resisting force by concrete punching shear strength. 

The design force will be the smallest of the all-resisting forces. 

2.5.1.1 Computing Soil Resisting Force: 

The force resisted by soil, Pu(soil) is found by multiplying the area of footing 

by the ultimate soil capacity as follows: 

where: 

Afooting = area of footing, m2 

Qa(soil) = allowable soil capacity, t/m2 

F = ultimate load factor, usually between 1.5 and 1.6 

 

2.5.1.2 Computing Flexural Resisting Force: 

(2.82)                                        )()( FQAP soilafootingsoilu =
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 From the given section dimensions and reinforcement, the bending 

moment capacity, Md is computed using the same principles of beam 

section analysis. The design moment, Md is then made equal the ultimate 

bending moment, Mu developed by a stress under the footing Qu(flexure). The 

ultimate force resisted by reinforced concrete, Pu(flexure) can be found using 

the following equations: 

   

Where a is the larger clear distance between the face of column and the 

edge of footing. 

2.5.1.3 Computing Wide Beam Shear Resisting Force: 

From the given section dimensions, the section shear capacity, Vd is found 

using the same principles in beam section shear analysis. Then, Vd is made 

equal the ultimate shear force, Vu developed by the soil stress Qu(shear). The 

shear resisting force, Pu(shear) is computed as follows: 

 Where d is the effective depth of footing section. 

2.5.1.4 Computing Punching Shear Resisting Force: 

The resisting punching shear strength, Pu(punching) is computed by 

multiplying the critical shear area by the concrete stress capacity, Vcp 

which is given by: 
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Where: 

Φ = shear strength reduction factor, the default value is 0.85 

βc =  the ratio of long side to short side of column 

αs = value depends on column location. It equals 40 for interior columns, 

30 for edge columns and 20 for corner columns. 

b, h = column dimensions 

Equations 2.85a and 2.85b are used in punching shear calculations in the 

program. 

2.5.2 Single Footing Design: 

The major steps in design of footing are: 

1. Compute footing area 

2. Compute footing depth from wide beam shear and punching shear 

3. Compute flexural reinforcement in each direction of footing 

2.5.2.1 Computing Footing Area: 

The footing area is computed using the following equation: 
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The dimensions of the base of the footing L and B are computed depending 

on the column dimensions; the clear distance between the face of column 

and the edge of the footing is equal in both directions. The footing effective 

depth is computed using the minimum value calculated in the following 

two sections. 

2.5.2.2 Computing Footing Depth from Wide Beam Shear: 

The ultimate stress under the footing is computed using the following 

equation: 

 The ultimate shear force is 

 

Where a is the clear distance between the face of column and the edge of 

the footing.  

The section shear strength is 

 

From Equations 2.88 and 2.89, the footing effective depth is computed 

considering Vu in equation 2.88 equals Vd in equation 2.89. 

 

2.5.2.3 Computing Footing Depth from Punching Shear:  
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The concrete punching strength, Vcp is found using Equations 2.85. The 

footing effective depth, d is found by making the applied ultimate load, Pu  

is to be equal to Pu(punching) in Equation 2.85f.  

2.5.2.4 Computing Flexural Reinforcement: 

As the clear distance from column face to footing edge, a  is equal in both 

footing directions, the bending moments and the areas of steel will be the 

same in both directions. The bending moment at column face will be 

Then the area of steel is computed. The area of steel should be larger than 

the minimum value required for temperature and shrinkage: As = 0.0018bh 

for sections reinforced with grade 4200kg/cm2 and 0.002bh with grade less 

than 4200kg/cm2 . b is the footing width and h is the footing thickness. 

Also, the computed area of steel should not exceed the maximum value for 

single reinforcement. 

After computing the areas of steel, the size and spacing of bars are 

determined in the long and short directions: 

a. The steel is uniformly distributed across the width of footing in the 

long direction. 

b. The portion As1 of the total steel area As determined for short 

direction is to be uniformly distributed over the central band: 
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Where β is the ratio of long side to short side of the footing. The remainder 

of the reinforcement (As-As1) is to be uniformly distributed outside the 

central band of the footing.  The central band width is equal to the footing 

short side dimension.  

 The previous discussion of analysis and design of footing is illustrated in 

the flowcharts in Figures 2.58 to 2.74. The flowcharts are transformed to 

the subroutines Footing_PuBearingCapacity, Footing_PuWide, 

Shear_Capacity_WithoutAxial_Vc, Footing_PuPunching, Footing_ 

Punching_BetaC, Footing_Punching_Area, Footing_MinSteel, Footing_ 

PuBending, Footing_Qu, Footing_Mu, Footing_Vu, Footing_Design_Area, 

Footing_WideShear_Df, Footing_Punching_Df, Footing_Punet and 

Footing_Rectangle_reinforcement_ShortDirection. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure 2.58 Flowchart to calculate Pu from soil capacity, 
subroutine Footing_PuBearingCapacity 
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Figure 2.59 Flowchart to calculate Pu from wide beam shear 
capacity, subroutine Footing_PuWide 

Figure 2.59 continued 
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Figure 2.60 Flowchart to calculate shear capacity, 
subroutine Shear_Capacity_WithoutAxial_Vc 

Figure 2.61 Flowchart to calculate Pu from punching shear 
resistance, subroutine Footing_PuPunching 
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Figure 2.62 Flowchart to calculate the allowable punching 
stresses, subroutine Footing_Punching_Vcp 

2/1 dDist >

2/2 dDist >

LB
DistDist

P
P vcp

punchingu 4*31
)(

−
=  

End

Start

21

21

   and   of minimum  theis  

06.1  ,2153.0

tCnching_BeaFooting_Pu

cpcpcp

ccpc
c

cp

VVV

fVfV =⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
+=
β

 

End

hb ≥

bhc /=β  

Yes 

Yes 

Yes 



  91

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 2.63 Flowchart to calculate βc: the ration of longer to shorter 
dimensions of column, subroutine Footing_Punching_BetaC  

Figure 2.64 Flowchart to calculate the area for punching 
shear computations, subroutine Footing_Punching_Area 
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Figure 2.65 Flowchart to calculate minimum steel area in footing section, 
subroutine Footing_MinSteel 

dhDist +=303 =Dist

2/2 dDist >

large very :)(bendinguP  

Yes 

Start

4200<yf  

bhAs 002.0min =  bhAs 0018.0min =  

End

Yes



  93

 

 
 

 
 
 

 
 
 

 
 
 
 

Figure 2.66 Flowchart to calculate Pu from flexure reinforcement 
capacity, subroutine Footing_PuBending 

Figure 2.67 Flowchart to calculate soil stress, Qu, subroutine 
Footing_Qu 

Figure 2.68 Flowchart to calculate the bending moment, Mu at face 
of column due to Qu, subroutine Footing_Mu
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Figure 2.70 Flowchart to compute footing dimensions, 
subroutine Footing_Design_Area 

 

Figure 2.69 Flowchart to calculate the shear force, Vu at face of 
column, subroutine Footing_Vu 

Figure 2.71 Flowchart to calculate footing effective depth from 
wide beam shear, subroutine Footing_WideShear_Df 
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Figure 2.72 Flowchart to calculate footing effective depth 
from punching shear, subroutine Footing_Punching_Df 

Figure 2.73 Flowchart to calculate the net axial load on 
the footing, subroutine Footing_Punet Figure 2.74 Flowchart to calculate areas of steel in short direction of 

footing, subroutine Footing_Rectangle_reinforcement_ShortDirection
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Chapter Three 
The program Composition 

3.1 General 

The program is composed of the main screen or form that has the main 

menu. Each menu contains submenus. Each submenu displays a dialog box 

that contains input and or output data. Also, a tool bar that contains buttons 

to run the most important submenus supports the main screen.  

In this chapter, the subroutines that are executed by the submenus will be 

introduced by flowcharts. These flowcharts use the basic subroutines 

discussed in chapter two for the analysis and design of the reinforced 

concrete section. All the variables in the flowcharts will be defined.  Also, 

the shape of the input dialog box will be shown and its input variables are 

to be defined.  

3.2 Language and Units: 

The program deals with the Arabic and English languages and the metric 

(ton, meter) and the SI (kilonewton, meter) units. As the program starts, a 

dialog box will ask the user for the language and units. The dialog box is 

shown in Figure 3.1 (form name: First, file: First.frm). The variables that 

are read by this dialog are: 

Language_ID: identifier for the language. It takes Arabic or English values 

Units_ID: identifier for the units. It takes Ton_Meter or Kilonewton_Meter 

values. 
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Figure 3.1 Language and units dialog box. 

 

3.3 The Program Main Menu: 

The program is composed of ten menus as shown in Figure 3.2a in English 

and in Figure 3.2b in Arabic (form name: MainForm, file: 

MDIForm.frm). Each menu contains submenus. Table 3.1 shows the 

names of the menus and submenus. Each menu will be detailed in the 

following sections. 
 
Table 3.1 the program menus 
Main 
Menu 

Submenus 

File New Project, Open, Save, Print Setup, Exit 
Edit Add, Insert, Modify, Delete, Delete All 
Define Materials, Sections, Design Load Combinations 
Select Select All, Clear Selection 
Assign Sections, Reinforcement, Forces, Reinforcement Design 

Options 
Analyze Start Analysis/ Show Results 
Design Start Design/ Show Results, Redefine Element Design Data 
Display Show Sections, Show Input Section Forces 
Options Preferences 
Help  
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Figure 3.2a Program screen (English) 

 

 

Figure 3.2b Program screen(Arabic) 
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3.4 The File Menu: 

This menu deals with the file operations as shown in table 3.1 

3.4.1 The New Project Submenu: 

This submenu is used to enter the name of the project, the run mode and the 

number of sections to be run. The New Project dialog box is shown in 

Figure 3.3 (form name: NewProject, file:NewProject.frm).  

 

Figure 3.3 New Project dialog box 

 

The variables that are read by this dialog are: 

ProjectName: the project name 

Run_ID: the analysis or design options. It takes Analysis or Design values 

Elements_Count: the number of sections to be analyzed or designed. It is 

limited to 50. 

Clicking on the OK button will display the list of elements (form name: 

ElementSections, file: ElementSections.frm), see Figure 3.2. 

3.5 The Edit Menu 

This menu is used to modify the element names or arrangements in the 

element list. The element names can be added, inserted, deleted or changed. 

The Add submenu displays the Add dialog box (form name: AddElement, 

file: AddElem.frm), the Insert submenu displays the Insert dialog box 
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(form name: InsertElement, file: InElem.frm) and the Modify submenu 

displays the Modify dialog box (form name: ModifyElements, file: 

ChElem.frm).  

Figure 3.4 Add dialog box                     Figure 3.5 Insert dialog box 

 

Figure 3.6 Modify dialog box 

 

3.6 The Define Menu: 

This menu is used to enter the materials properties, sections and load 

combinations. 

3.6.1 The Materials Submenu: 

This submenu is used to enter the materials names and properties. Figure 

3.7 shows the Define Materials dialog (form name: DefineMaterials, file: 

DefineMaterials.frm). The properties of each material is entered using the 

Material Property Data dialog box as shown in Figure 3.8 (form name: 

ShowMaterial, file: ShowMaterial.frm).  
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Figure 3.7 Define Materials dialog box 
 

Figure 3.8 Material Property Data dialog box 

 

The variables that are read by these dialogs are: 

Material_Name( ): material name 

Material_Fc( ): the compressive strength of concrete  

Material_Fy( ): the yield strength of the flexural reinforcing steel  

Material_Fys( ): the yield strength of the shear reinforcing steel 

Material_ID( ): identifier for the material name (number) 

3.6.2 The Sections Submenu: 

This submenu is used to define the sections names and properties.  It will 

display the Define Sections dialog as shown in Figure 3.9 (form name: 

DefineFrameSections, file: DefineSections.frm). The section material, 

name and dimensions are entered using the Show Section dialog as shown 

in Figure 3.10 (form name: ShowFrameSections, file: 

ShowSection.frm). Also, this submenu specifies the section as beam or 
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column. The beam section properties are entered using the Beam Data 

dialog as shown in Figure 3.11, while the column properties are entered 

using the Column Data dialog as shown in Figure 3.12 (form name: 

ColumnData, file: ColumnDta.frm).  The footing properties are defined 

using the Define Footing dialog as shown in Figure 3.13 (form name: 

DefineFooting, file:DefineFooting.frm).  

 

 

Figure 3.9 Define Sections dialog 

Figure 3.10 Show Section dialog 
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Figure 3.11 Beam Data dialog                   Figure 3.12 Column Data dialog 

 

Figure 3.13 Define Footing dialog  

 

The variables that are read by these dialogs are defined as follows: 

Sections_Name( ): the name of the section 

Sections_ID( ): identifier for the section 

Sections_Material( ): the name of the material to the specified section 

Sections_MaterialID( ): identifier for the section material 

Sections_Type( ): the type of the section beam or column 

Sections_Shape( ): the shape of the section rectangle, T_Section or 

L_Section 

Sections_Footing_ID( ): identifier to the column section that has a footing 

to analyze or design or not 

Sections_H( ): the height of the section; the major dimension 
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Sections_B( ): the width of the section; the minor dimension 

Sections_BF( ): the width of the flange in flanged section 

Sections_HF( ): the thickness of the flange in flanged section 

Beam section: 

Sections_Beam_Tcover( ): the beam section reinforcement top cover to 

center of bars 

Sections_Beam_Bcover( ): the beam section reinforcement bottom cover 

to center of bars 

Sections_Beam_Scover( ): the beam section reinforcement sides cover to 

center of bars 

Column section: 

Sections_Column_Cover( ): the column section reinforcement cover to 

center of bars 

Sections_Column_Length( ): the column length (height) 

Footing: 

Sections_Footing_Material( ): the material for footing 

Sections_Footing_MaterialID( ): identifier for the footing material 

(number) 

Sections_Footing_LoadFactor( ): the dead and live loads average load 

factor 

Sections_Footing_Cover( ): footing section  reinforcement cover to center 

of bars  

Sections_Footing_Soil_Capacity( ): the soil allowable bearing capacity 

 

3.6.3 The Design Load Combinations Submenu: 
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The program introduces eleven load combinations that are specified by the 

ACI code. This submenu is active only in the design mode. Figure 3.14 

shows the Define Load Combinations dialog (form name: 

DefineLoadCom, file: AssignLoadComb.frm). The user can select the 

appropriate load combinations and can change the load factors. The default 

load factors are that specified by the ACI code.  The load combinations are 

very important for the section design. The program considers that dead and 

live loads cause no sidesway and wind, quick and other loads cause 

sidesway. This system is very important in the column design.  

 

Figure 3.14 Define Load Combinations dialog 

 

The variables that are read by this dialog are defined as follows: 

Load_Combinations_Factors(n,m): the load combination factors. The 

variable n is varied from one to eleven that equals the number of the load 

combinations. The variable m is varied from one to five that equals the 

number of loads. 

Check1( ): identifier that equals 1 if the load combination is selected and it 

equals 0 if the load combination is not selected. 
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3.7 The Select Menu: 

This menu is used for selection of elements in the element list.  

3.8 The Assign Menu: 

This menu is used to assign each element in the element list; after selection; 

to its specified section, reinforcement (analysis), forces (design) and 

reinforcement design options (design).  

3.8.1 The Sections Submenu: 

This menu is used to assign a section to element or elements. This submenu 

displays the Define Frame Section dialog shown in Figure 3.9 (shown 

previously). The assignment is achieved by selecting the section name and 

then clicking the OK button.  In this stage, the section properties can be 

modified.  

The only variable that is read by this dialog in the assign menu is 

Element_SectionID(), which it is a number that specifies the section name 

to the element. From this variable all the section and material properties of 

the element are defined.  

3.8.2 The Reinforcement Submenu: 

This submenu is used to assign the existing reinforcing steel to the section 

for analysis. This submenu displays the Assign Reinforcement dialog box. 

The variables in this dialog depend on the section type (beam or column). 

Figure 3.15 shows the Assign Beam Reinforcement dialog  (form name: 

Reinforcement, file: Reinforcement.frm), Figure 3.16 shows the Assign 

Column Reinforcement dialog and Figure 3.17 shows the Assign Footing 

Dimensions and Reinforcement for Analysis dialog (form name: 

AssignFootingData, file: AnFooting.frm). 
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Figure 3.15 Assign Beam Reinforcement dialog 

 

Figure 3.16 Assign Column Reinforcement dialog 
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Figure 3.17 Assign Footing Dimensions and Reinforcement for Analysis 
dialog 

 

The variables that are read by these subroutines are defined as follows: 

Beam section: 

Element_Reinforcement_Type( ): option for reinforcement type, bars or 

area 

Element_NoTBars( ): number of top bars 

Element_Tdiam( ): diameter of top bars in mm 

Element_NoBBars( ): number of bottom bars 

Element_BDiam( ): diameter of bottom bars 

Element_AnStirrups_No( ): number of stirrups in the section 

Element_AnStirrups_Diam( ): stirrups diameter 

Element_AnStirrups_Spacing( ): stirrups spacing 

Element_AnStirrups_Avs( ): shear reinforcement Av/s 

Element_TArea( ): area of top steel (cm2) 

Element_Barea( ): area of bottom steel (cm2) 

 

Column section: 
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Element_AnColBars22( ): number of bars at each side of column section 

parallel to its height, h 

Element_AnColBars33( ): number of bars at each side of column section 

parallel to its width, b 

Element_AnColBarDiam( ): column bar diameter 

Element_AnColBarArea( ): column bar area 

The stirrups variables are as for beam section and so the type of 

reinforcement variable. 

Footing: 

Element_Footing_AnBT( ): side length of footing parallel to width of 

column, b 

Element_Footing_AnHT( ): side length of footing parallel to length of 

column, h 

Element_Footing_AnDepth( ): total depth of footing 

Element_Reinforcement_Type( ): option for reinforcement type, bars or 

area 

Element_Footing_NoBarsHT( ): number of reinforcement bars in 

direction h 

Element_Footing_BarsHTDiam( ): diameter of bars in direction h 

Element_Footing_NoBarsBT( ): number of reinforcement bars in 

direction b 

Element_Footing_BarsBTDiam( ): diameter of bars in direction b 

Element_Footing_AstHT( ):area of steel in direction h 

Element_Footing_AstBT( ): area of steel in direction b 

3.8.3 The Forces Submenu 
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This submenu is used to assign the design forces to the element section. 

This submenu displays the Assign Beam Forces dialog for a beam section 

type as shown in Figure 3.18, and displays the Assign Column  Forces 

dialog for a column section as shown in Figure 3.19 (form name: 

AssignDesignForces, file: AssignColumnForces.frm).  

Figure 3.18 Assign Beam Forces dialog 

Figure 3.19 Assign Column Forces dialog  

 

The variables that are read from these dialogs are: 

Beam section: 

Element_Beam_F11(n,m): the axial forces 

Element_Beam_T11(n,m): the torsional moments 
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Element_Beam_V22(n,m): the shear forces in the major direction; parallel 

to h 

Element_Beam_M33(n,m): the bending moments in major direction  

The variable n is equal to the element number and m ranges from one to 

five, which is the number of load. 

Column section: 

Element_Column_F11(n,m): the axial forces 

Element_Column_T11(n,m): the torsional moments 

Element_Column_V22(n,m): the shear forces in the major direction; 

parallel to h 

Element_Column_V33(n,m): the shear forces in the minor direction;  

parallel to b 

Element_Column_M33(n,m): the bending moments in the major direction 

at the specified section 

Element_Column_M22(n,m): the bending moments in the minor direction 

at the specified section 

Element_Column_TopM33(n,m): the bending moments in the major 

direction at top end of column 

Element_Column_TopM22(n,m): the bending moments in the minor 

direction at top end of column 

Element_Column_BottomM33(n,m): the bending moments in the major 

direction at bottom end of column 

Element_Column_BottomM22(n,m): the bending moments in the minor 

direction at bottom end of column 
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Element_Column_SpanLoads( ): identifier equals to 1 if having span 

loads and it equals to 0 if having no span loads. If having span loads, the 

moment factor, Cm (see chapter 2) is equal to 1 as a minimum value. 

Element_Column_SpanMoments( ): identifier equals to 1 if having span 

moments and it equals to 0 if having no span moments. If having span 

moments, the design will be only for these moments, else the design will be 

for the end moments. 

3.8.4 The Reinforcement Design Options Submenu: 

This menu is used to specify the design options dealing with the bars 

diameters and arrangement. For the beam section, the diameter of the main 

and shear bars are to be entered using the Assign Beam Reinforcement 

dialog as shown in Figure 3.20. For the column section, there are two 

options. The first: the main bars arrangement and the shear reinforcing steel 

bar diameter is to be entered. In this option, the program designs the main 

steel bar diameter for the given reinforcement arrangement as shown in 

Figure 3.21.  The second: the main bars diameter and the shear reinforcing 

steel bar diameter is to be entered. In this option, the program designs the 

bars arrangement for the given bar diameter as shown in figure 3.22 (form 

name: AssignDesignReinforcement, file: AsFotReinf.frm). 

Figure 3.20 Assign Beam                    Figure 3.21 Assign Column  
Reinforcement dialog                           Reinforcement dialog/ Bars layout 
                                                              dialog 
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Figure 3.22 Assign Column Reinforcement/Bars diameter dialog 

 

The variables that are read by these dialogs are defined as follows: 

Element_Design_Reinforcement_Type( ): identifier for the design option. 

1 for bars layout and 2 for bars diameter 

Element_Design_MainDiameter( ): the bar diameter for main steel in mm 

Element_Design_ShearDiameter( ): the bar diameter for shear steel in 

mm 

StirrupsBarsDiameter( ): equals to Element_Design_ShearDiameter( ) 

SectionStirrupsNo( ): equals to 1. The number of stirrups in a section 

Beam section: 

TopBarsDiameter( ): the diameter of top bars. It equals to 

Element_Design_MainDiameter( ) 

BottomBarsDiameter( ): the diametr of bottom bars. It equals to 

Element_Design_MainDiameter( ) 

MiddleBarsDiameter( ): the diameter of middle bars. It equals to 

Element_design_MainDiameter( ) 

 

Column section:  
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Element_Design_Column_Bars22( ): the number of bars at each side of 

column parallel to direction h; the minor direction 

Element_Design_Column_Bars33( ): the number of bars at each side of 

column parallel to direction b; the major direction 

Footing: 

FootingBarsDiameter( ): the diameter of reinforcing steel in footing 

section 

3.9 The Analyze Menu: 

This menu executes the program in the analysis mode by clicking on the 

Start Analysis/ Show Results submenu. 

3.9.1 The Start Analysis/ Show Results Submenu: 

This menu runs the subroutines needed for analysis of beam and column 

sections and displays the Analysis Output dialog as shown in Figure 2.23 

(form name: AnalysisOutput, file: AnalysisOutput.frm). This dialog 

contains a table of the data. For the beam section, the table shows the 

positive and negative moment capacities (Beam/M+, Beam/M-) and the 

design shear capacity at zero axial force (Shear/Vd2). For the column 

section, the table shows the design shear capacity in the major and minor 

directions at zero axial force (Shear/Vd2, Shear/Vd3). Also, the Analysis 

Output dialog contains command buttons for footing analysis, displaying 

shear_axial interaction diagrams, displaying bending moment_axial 

interaction diagrams for the column section and displaying the analysis 

details. The details of these command buttons will be illustrated later.  
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Figure 2.23 the Show Analysis Output dialog 

 

The flowchart of the main subroutine of this submenu is shown in Figure 

3.24. In the flowchart, EN is the number of elements to be analyzed. The 

code of this subroutine is found in the form MainForm in the file 

MDIForm.frm in Appendix A. 

 

 
Figure 2.24 flowchart for the subroutine of Start Analysis/ Show 
Results submenu 

Start

EN>0

J1=1

 Element_Analysis(J1); subroutine for analysis of one 
section 

J1<EN

J1=J1+1 

Yes 

End

Yes 
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The flowchart of the subroutine Element_Analysis is shown in Figure 2.25. 

The variables in this flowchart will be defined as follows: 

Element_Name(J1): element name 

Element_Section(J1): name of element section 

Element_Material(J1): name of material 

Element_Shape(J1): element section shape 

Element_Type(J1): element type; beam or column 

Element_Fc(J1): element concrete compressive strength 

Element_Fy(J1): element main steel yield strength 

Element_Fys(J1): element shear steel yield strength 

Element_B(J1): element section width 

Element_H(J1): element section total depth 

Element_BF(J1): element section flange width 

Element_HF(J1): element section flange thickness 

Element_TCover(J1): element section top concrete cover to bars center 

Element_BCover(J1): element section bottom concrete cover to bars 

center 

Element_SCover(J1): element section sides concrete cover to bars center 

BeamMuP(J1): beam positive moment capacity (using bottom steel as the 

tension steel) 

BeamMuN(J1): beam negative moment capacity (using top steel as the 

tension steel) 

MuPCheck(J1): identifier for the state of the existing reinforcement in 

positive moment calculations: it equals 1 if the area of steel is less than the 

minimum, 0 if the area of steel is larger than the minimum and less than the 

maximum and 2 if the area of steel is larger than the maximum. 
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MuNCheck(J1): identifier for the state of the existing reinforcement in 

negative moment calculations: it equals 1 if the area of steel is less than the 

minimum, 0 if the area of steel is larger than the minimum and less than the 

maximum and 2 if the area of steel is larger than the maximum 

AsMax(J1): the maximum area of steel for singly reinforced beam section 

BeamVsMax(J1): the maximum allowed value of shear force due to 

existing reinforcement for beam section in the major direction, see chapter 

two  

BeamTuCapacity(J1): the concrete torsional moment capacity  for beam 

section   

VsMax2(J1): the maximum allowed value of shear force due to existing 

reinforcement in the major direction of column section 

VsMax3(J1): the maximum allowed value of shear force due to existing 

reinforcement in the minor direction of column section 

Tc2(J1): the concrete torsional moment capacity  for beam section in the 

major direction  

Tc3(J1): the concrete torsional moment capacity  for beam section in the 

minor direction 
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Figure 3.25a Flowchart for beam section column analysis, 
subroutine Element_Analysis(J1) 

Start

Read the final variables of the element: 
Element_Name(J1)= name of element from elements list 
Element_Section(J1)= Sections_Name(Element_SectionID(J1)) 
Element_Material(J1)= 
Material_Name(Sections_MaterialID(Element_SectionID(J1))) 
Element_Shape(J1)= Sections_Shape(Element_SectionID(J1)) 
Element_Type(J1)= Sections_Type(Element_SectionID(J1)) 
Element_B(J1)= Sections_B(Element_SectionID(J1)) 
Element_H(J1)= Sections_H(Element_SectionID(J1)) 
Element_Fc(J1)= Material_Fc(Sections_MaterialID(Element_SectionID(J1))) 
Element_Fy(J1)= Material_Fy(Sections_MaterialID(Element_SectionID(J1))) 
Element_Fys(J1)= Material_Fys(Sections_MaterialID(Element_SectionID(J1))) 

B=Element_B(J1)*100     cm 
H=Element_H(J1)*100    cm 

Units_ID= 
Ton_Meter

Fc=Element_Fc(J1)/10   kg/cm2 
Fy=Element_Fy(J1)/10   kg/cm2 
Fys=Element_Fys(J1)/10   kg/cm2 

Fc=Element_Fc(J1)/98.0665   kg/cm2 
Fy=Element_Fy(J1)/98.0665   kg/cm2 
Fys=Element_Fys(J1)/98.0665   kg/cm2

Yes 

Element_Type(J1)=Beam

Column analysis: see 
Figure 3.25b Yes 

A 
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Figure 3.25a continued 
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Read the final variables of the element: 
Element_HF(J1)= Sections_HF(Element_SectionID(J1)) 
Element_BF(J1)= Sections_BF(Element_SectionID(J1)) 
Element_TCover(J1)=Sections_Beam_TCover(Element_SectionID(J1)) 
Element_BCover(J1)=Sections_Beam_BCover(Element_SectionID(J1)) 
Element_SCover(J1)=Sections_Beam_SCover(Element_SectionID(J1)) 

A 

For positive moment capacity calculations: 
dc= Element_Bcover(J1)*100          cm 
dt= Element_TCover(J1)*100         cm 
As= Element_Barea(J1) 
As’= Element_TArea(J1) less than or equals As 

Element_Shape(J1)= 
Rectangle

Yes  

Element_HF(J1)=0 
Element_BF(J1)=0 
Rectangular_Beam_Analysis

hf= Element_HF(J1)  
bf= Element_BF(J1) 
Flanged_Beam_Analysis 

Units_ID=  
Ton_Meter 

BeamMuP(J1)= 
Mu 

BeamMuP(J1)= 
Mu*9.80665 

Yes  

Units_ID=  
Ton_Meter 

BeamMuP(J1)= 
Mu 

BeamMuP(J1)= 
Mu*9.80665 

Yes 

RhoMax_Rectangle 
bdmaxAsMax(J1) ρ=  

RhoMax_FlangedSection 
dbfmaxAsMax(J1) ρ=

B 
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Figure 3.25a continued 

B 

Check_Rho_Min=1

MuPCheck(J1)=1 

MuPCheck(J1)=0

Check_Enlarge_Section=1

MuPCheck(J1)=2 

Yes  

Yes  

MuPCheck(J1)=0 

For negative moment capacity calculations: 
dc= Element_Tcover(J1)*100          cm 
dt= Element_BCover(J1)*100         cm 
As= Element_TArea(J1) 
As’= Element_BArea(J1) less than or equals As 

Rectangular_Beam_Analysis

Units_ID= Ton_Meter

BeamMuN(J1)=Mu BeamMuN(J1)=Mu*9.80665 

C 

Yes 

Yes  
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Figure 3.25a continued 

Check_Rho_Min=1

MuNCheck(J1)=1 MuNCheck(J1)=0

Check_Enlarge_Section=1

MuNCheck(J1)=2 

Yes  

MuNCheck(J1)=0 

C 

Analysis for shear and torsion: the program takes 10 points 
for the axial force between –0.1fc’Ag and 0.1fc’Ag. Vc, Vs 
and Vd will be calculated for each point  to be used in the 
axial force_shear interaction diagram .  IV=1 

Element_Reinforcement_Type=1 
1: bars,  2:area

Yes StirrupsNo,n= Element_AnStirrups_No(J1) 
StirrupsDiam, db=Element_AnStirrups_Diam(J1) 
StirrupsSpacing,s=Element_AnStirrups_Spacing(J1) 
Section_Design_Shear_Capacity 

D E  

V  
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Figure 3.25a continued 

E

(Av/s)= Element_AnStirrups_Avs(J1) 
ShearReinforcement_Capacity_Vs 
Shear_VsMax

maxss VV >

maxss VV =  

D  

Yes

Concrete_Shear_Capacity 
Shear_Vn_Vs 

Units_ID= 
Ton_Meter

uu

cc

ss

VIVJV
VIVJV
VIVJV

=
=
=

),1(
),1(
),1(

 
80665.9*),1(
80665.9*),1(
80665.9*),1(

uu

cc

ss

VIVJV
VIVJV
VIVJV

=
=
=

 

Yes 

10≤IV

1+= IVIV

V 

Yes 

F 
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Figure 3.25a continued 

F 

Shear_VsMax 
Torsion_Section_Properties 
Torsion_Tmin 

Units_ID= 
Ton_Meter

BeamVsMax(J1)=Vsmax 
BeamTuCapacity(J1)=Tmin 

BeamVsMax(J1)=Vsmax*9.80665 
BeamTuCapacity(J1)=Tmin*9.80665 

Yes 

Output data: 
BeamMuP(J1), BeamMuN(J1), 
MuPCheck(J1), MuNCheck(J1), 
BeamVsMax(J1), BeamTuCapacity(J1), 10 
points for axial force_shear interaction 
diagram

End
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Figure 3.25b Flowchart for column section analysis, subroutine 
Element_Analysis(J1) 

From Figure 3.25a

Read variables: 
Element_Cover(J1)= 
Sections_Column_Cover(Element_SectionID(J1)) 
ColumnAnBarsTotal(J1)= 
2*Element_AnColBars33(J1)+2*(Element_AnColBars22(J1)-2) 
ColumnAnAstTotal(J1)= 
ColumnAnBarsTotal(J1)*Element_AnBarArea(J1) 
As=ColumnAnAsTotal(J1) 
dc= Element_Cover(J1)

Analysis for shear and torsion in the major direction: 
B=Element_B(J1) 
H= Element_H(J1) 
D= h-dc 
Ultimate_Axial_Capacity 
Tension_AxialCapacity 

The program takes 20 points of the axial force between the maximum compression 
capacity, Pu and the tension capacity, Put. Vc, Vs and Vu are to be calculated for 
each point.  
IV=1 

Element_Reinforcement_Type=1 
1:bars,  2:area

Yes 

StirrupsNo,n= Element_AnStirrups_No(J1) 
StirrupsDiam, db=Element_AnStirrups_Diam(J1) 
StirrupsSpacing,s=Element_AnStirrups_Spacing(J1) 
Section_Design_Shear_Capacity 

W  

G 

H  
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Figure 3.25b continued 

(Av/s)= Element_AnStirrups_Avs(J1) 
ShearReinforcement_Capacity_Vs 
Shear_VsMax

maxss VV >  

maxss VV =  

H  

Yes

G 

Concrete_Shear_Capacity 
Shear_Vn_Vs 

Units_ID= 
Ton_Meter

uu

cc

ss

VIVJV
VIVJV
VIVJV

=
=
=

),1(
),1(
),1(

 
80665.9*),1(
80665.9*),1(
80665.9*),1(

uu

cc

ss

VIVJV
VIVJV
VIVJV

=
=
=

 

Yes 

20<IV

1+= IVIV

W 

Yes 

I 
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Figure 3.25b continued 

I 

Shear_VsMax 
Torsion_Section_Properties 
Torsion_Tmin 

Units_ID= 
Ton_Meter

VsMax2(J1)=Vsmax 
Tc2(J1)=Tmin 

VsMax2(J1)=Vsmax*9.80665 
Tc2(J1)=Tmin*9.80665 

Yes 

Output data: 
VsMax2(J1), Tc2(J1), VsMax3(J1), 
Tc3(J1), 20 points for axial force_shear 
interaction diagram 

End

Analysis of column section for shear and torsion in minor direction: 
b=Element_H(J1)*100        cm,   h=Element_B(J1)*100        cm 
d=h-dc 
the previous procedure for the major direction is used 
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The Footing Analysis command button in the Output Analysis dialog runs a 

subroutine for analysis of footing. The results are displayed in the form 

Details, file DesignDetails.frm as shown in Figure 3.26. Figure 3.27 shows 

the subroutine flowchart. The variables in the flowchart are defined as 

follows: 

Element_Footing_Material(SL1): the material for the footing section 

Element_Footing_Fc(SL1): the compressive strength of concrete for the 

footing section 

 Element_Footing_Fy(SL1): the steel yield strength for the footing section 

 Element_Footing_LoadFactor(SL1): average load factor for the dead 

and live loads 

Element_Footing_SoilCapacity(SL1): allowable soil capacity 

Element_Footing_Cover(SL1): concrete cover in footing section 

BC: column width 

HC: column length 

BT: footing width 

LT: footing length 

FootingPu(SL1,1): the calculated Pu from soil capacity 

FootingPu(SL1,2): the calculated Pu from wide beam shear capacity in L 

direction 

FootingPu(SL1,3): the calculated Pu from wide beam shear capacity in B 

direction 

FootingPu(SL1,4): the calculated Pu from punching shear capacity 

FootingPu(SL1,5): the calculated Pu from flexural strength in L direction 

FootingPu(SL1,6): the calculated Pu from flexural strength in B direction 

FootingPuMax(SL1): the maximum value of Pu from the previous values 

FootingMuL(SL1): the bending moment at face of column in L direction 
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FootingMuB(SL1): the bending moment at face of column in B direction 

FootingVuL(SL1): the shear force at distance d from face of column in L 

direction 

FootingVuB(SL1): the shear force at distance d from face of column in B 

direction 

FootingID2(SL1): identifier for the existing area of steel: 

 1: if area of steel in direction L is less than the minimum 

 2: if area of steel in direction L is larger than the maximum 

 3: if area of steel in direction B is less than the minimum 

 4: if area of steel in direction B is larger than the maximum 
 

Figure 3.26 Show Footing Analysis dialog 
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Figure 3.27 Flowchart for footing analysis 
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Figure 3.27 continued 

Start

The footing section variables: 
Element_Footing_Material(SL1)=Material_Name(Element_SectionID(SL1)) 
Element_Footing_Fc(SL1)= Material_Fc(Element_SectionID(SL1)) 
Element_Footing_Fy(SL1)=Material_Fy(Element_SectionID(SL1)) 
Element_Footing_LoadFactor(SL1)=Sections_Footing_LoadFactor(Element_Section
ID(SL1)) 
Element_Footing_Soil_Capacity(SL1)=Sections_Footing_Soil_Capacity(Element_Se
ctionID(SL1)) 
Element_Footing_Cover(SL1)=Sections_Footing_Soil_Capacity(Element_SectionID
(SL1)) 

Units_ID=Ton_Meter

Fc=Element_Footing_Fc(SL1)/10  kg/cm2 
Fy=Element_Footing_Fy(SL1)/10  kg/cm2 

Fc=Element_Footing_Fc(SL1)/98.0665  kg/cm2 
Fy=Element_Footing_Fy(SL1)/98.0665  kg/cm2 

A 

Yes  
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LoadFactor=Element_Footing_LoadFactor(SL1)

Units_ID= 
Ton_Meter

A 

BearingCapacity= 
Element_Footing_Soil_Capacity(SL1) 

BearingCapacity= 
Element_Footing_Soil_Capacity(SL1)/9.8066
5 

Yes 

BC=Element_B(SL1) 
HC=Element_H(SL1) 
Dc=Element_Footing_Cover(SL1)*100   cm 
Df= Element_Footing_AnDepth(SL1)- 
 Footing_Cover(SL1) 
BT=Element_Footing_AnBT(SL1) 
LT= Element_Footing_AnHT(SL1) 
B=100 
H=Element_Footing_AnDepth(SL1)*100   cm 
D=h-dc 
As’=0 

Footing_PuBearingCapacity

Units_ID=Ton_Meter

FootingPu(SL1,1)=PuBearingCapacity FootingPu(SL1,1)=PuBearingCapacity*9.
80665 

B 

Yes 

Units_ID=Ton_Meter
Yes  C 
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Figure 3.27 continued 

Figure 3.27 continued 

B 

Footing_PuWide

FootingPu(SL1,2)=PuWideShearL 
FootingPu(SL1,3)=PuWideShearB 

FootingPu(SL1,2)=PuWideShearL*9.80665 
FootingPu(SL1,3)=PuWideShearB*9.80665 

Footing_PuPunching

Units_ID=Ton_Meter

FootingPu(SL1,4)=PuPunching FootingPu(SL1,4)=PuPunching*9.80665 

Yes  

HT=Element_Footing_AnDepth(SL1) 
Beta_1 
Footing_MinSteel 
RhoMax_Rectangle 
As=Element Footing AstHT(SL1)
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C

minss AA <  

FootingID2(SL1)=1 

bhAs maxρ>  

Yes 

FootingID2(SL1)=2 
FootingPu(SL1,5)=0

FootingID2(SL1)=0

Yes  

LengthF=LT, LengthC=HC, Footing_PuBending

Units_ID=Ton_Meter

FootingPu(SL1,5)= 
PuBending 

FootingPu(SL1,5)= 
PuBending*9.80665 

Yes  

As=Element_Footing_AstBT(SL1)

minss AA <  

FootingID2(SL1)=3 

bhAs maxρ>  

Yes 

F Yes  
E 

D 
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Figure 3.27 continued 

DE 

FootingID2(SL1)=0
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FootingID2(SL1)=4 
FootingPu(SL1,6)=0 

LengthF=BT 
LengthC=BC 
Footing_PuBending

Units_ID= Ton_Meter

FootingPu(SL1,6)=PuBending 

Yes  

FootingPu(SL1,6)= 
PuBending*9.80665 

F 

Find minimum Pu: 
FootingPuMax(SL1)=FootingPu(SL1,1) 

N=2

FootingPu(SL1,N)< 
FootingPuMax(SL1)

FootingPuMax(SL1)=FootingPu(SL1,N)

G

Yes 

H 

6<N
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Figure 3.27 continued 

G

Yes 

N=N+1 H 

Units_ID=Ton_Meter

Pu=FootingPuMax(SL1) 

Pu=FootingPuMax(SL1)*9.80665

Yes 

Footing_Qu

LengthF=LT 
LengthC=HC 
Footing_Mu 
Footing_Vu

Units_ID=Ton_Meter

FootingMuL(SL1)=Mu 
FootingVuL(SL1)=Vu 

FootingMuL(SL1)=Mu*9.80665 
FootingVuL(SL1)=Vu*9.80665 

Yes 

I

LengthF=BT 
LengthC=BC 
Footing_Mu 
Footing_Vu
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The Pu_Vu2 and Pu_Vu3 commands each runs a subroutine to convert the 

points of the axial and shear forces calculated in the subroutine 

Element_Analysis(J1) to drawings as interaction diagrams as shown in 

Figure 3.28. 

Figure 3.27 continued 

I

Units_ID=Ton_Meter

FootingMuB(SL1)=Mu 
FootingVuB(SL1)=Vu FootingMuB(SL1)=Mu*9.80665 

FootingVuB(SL1)=Vu*9.80665 

Yes 

All the data in this flowchart for the selected 
element will be as output. The identifier 
FootingID2(SL1)= 1:  area of steel in direction 
L is less than the minimum. 2: area of steel in 
direction L is larger than the maximum. 3: area 
of steel in direction B is less than the minimum. 
4: area of steel in direction B is larger than the 
maximum

End
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Figure 3.28a Axial force_ shear force interaction diagram 

 

Figure 3.28b Interaction points of axial force_shear interaction diagram 

 

The Pu_Mu3 command runs a subroutine to calculate the points of axial 

forces and bending moments that are necessary for the drawing of the axial 

force_moment interaction diagram in the major direction of column section 

as shown in Figure 3.29. Figure 3.30 shows the flowchart of the subroutine.  
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Figure 3.29a Axial force_bending moment interaction diagram in the 
major direction 
 

Figure 3.29b Interaction points of the axial force_bending moment 
interaction diagram 
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Figure 3.29c Calculating moment value at a certain axial force  

The variables in the flowchart are defined as follows: 

ColHIPPn(SL1,1): the nominal maximum axial load capacity, Pn 

ColHIPPn(SL1,2): 0.8Pn 

ColHIPPn(SL1,3): nominal axial load between the balanced force, Pnb and 

0.8Pn 

ColHIPPn(SL1,4): nominal axial load between the balanced force, Pnb and 

0.8Pn 

ColHIPPn(SL1,5): nominal balanced force, Pnb 

ColHIPPn(SL1,6): nominal axial load of 0.1fcAg 

ColHIPPn(SL1,7): the nominal force at pure moment which it equals to 

zero 

ColHIPPn(SL1,8): pure tension force 

ColHIPPd(SL1,1): the design maximum axial load capacity, 0.7Pn 

ColHIPPd(SL1,2): 0.7(0.8)Pn 

ColHIPPd(SL1,3): design axial load between the balanced force, Pdb and 

0.7(0.8)Pn 

ColHIPPd(SL1,4): design axial load between the balanced force, Pdb and 

0.7(0.8)Pn 

ColHIPPd(SL1,5): design balanced force, Pdb 
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ColHIPPd(SL1,6): design axial load of  Φ 0.1fcAg 

ColHIPPd (SL1,7): the design force at pure moment which it equals to 

zero 

ColHIPPd(SL1,8): design pure tension force 

ColHIPMn(SL1,1): the nominal moment capacity at maximum axial load 

capacity, Pn which equals to zero 

ColHIPMn(SL1,2): the nominal moment at 0.8Pn 

ColHIPMn(SL1,3): nominal moment at nominal axial load between the 

balanced force, Pnb and 0.8Pn 

ColHIPMn(SL1,4): nominal moment at nominal axial load between the 

balanced force, Pnb and 0.8Pn 

ColHIPMn(SL1,5): nominal moment at nominal balanced force, Pnb which 

is Mnb 

ColHIPMn(SL1,6): the nominal moment at nominal axial load of 0.1fcAg 

ColHIPMn(SL1,7): the  nominal  pure moment 

ColHIPMn(SL1,8): the nominal moment at nominal pure tension force 

ColHIPMd(SL1,1): the design moment capacity at maximum axial load 

capacity, 0.7Pn which equals to zero 

ColHIPMd(SL1,2): the design moment at 0.7(0.8)Pn 

ColHIPMd(SL1,3): design moment at design axial load between the 

balanced force, Pdb and 0.7(0.8)Pn 

ColHIPMd(SL1,4): design moment at design axial load between the 

balanced force, Pdb and 0.7(0.8)Pn 

ColHIPMd(SL1,5): design moment at the design balanced force, Pdb which 

is Mdb 
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ColHIPMd(SL1,6): the design moment at design axial load of Φ 0.1fcAg 

ColHIPMd(SL1,7): the  design pure moment 

ColHIPMd(SL1,8): the design moment at design pure tension force 
 

Figure 3.30 Flowchart of the subroutine that calculates points of 
the axial force_bending moment interaction diagram in column 
major direction  

 

Start

Units_ID= Ton_Meter Yes 



  144

 

The Pu_Mu2 command runs a subroutine to calculate the points of axial 

forces and bending moments that are necessary for the drawing of the axial 

force_moment interaction diagram in the minor direction of column 

section. Figure 3.31 shows the flowchart of the subroutine. The variables in 

the flowchart are defined as the variables in the flowchart in Figure 3.30 for 

the column section in the major direction. The variables are:  

ColBIPPn(SL1, 1 to 8): defines the nominal axial forces 

ColBIPPd(SL1, 1 to 8): defines the design axial forces 

ColBIPMn(SL1, 1 to 8): defines the nominal bending moments 

ColBIPMd(SL1, 1 to 8): defines the design bending moment 
 

 

Fc=Element_Fc(SL1)/10 
Fy=Element_Fy(SL1)/10 

Fc=Element_Fc(SL1)/98.0665 
Fy=Element_Fy(SL1)/98.0665 

B= Element_B(SL1) 
H= Element_H(SL1) 
Dc= Element_Cover(SL1) 
BarsH= Element_AnColBars33(SL1) 
BarsB=Element_AnColBars22(SL1) 
BarArea=Element_AnColBarArea(SL1)

Column_Reinforcement_Area_Depth 
Column_PM_Diagram 

The points of the interaction diagram are 
constructed: ColHIPPn(SL1, 1 to 8), 
ColHIPPd(SL1,1 to 8), ColHIPMn(SL1,1 
to 8), ColHIPMd(SL1, 1 to 8). Then, these 
points are converted to drawings

End

Start
Units_ID= Ton_Meter

Yes 
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Figure 3.31 Flowchart of the subroutine that calculates points of the 
axial force_bending moment interaction diagram in column minor 
direction 

Figure 3.31 continued 

Fc=Element_Fc(SL1)/10 
Fy=Element_Fy(SL1)/10 

Fc=Element_Fc(SL1)/98.0665 
Fy=Element_Fy(SL1)/98.0665 

B= Element_H(SL1) 
H= Element_B(SL1) 
Dc= Element_Cover(SL1) 
BarsH= Element_AnColBars22(SL1) 
BarsB=Element_AnColBars33(SL1) 
BarArea=Element_AnColBarArea(SL1)

Column_Reinforcement_Area_Depth 
Column_PM_Diagram 

The points of the interaction diagram are 
constructed: ColBIPPn(SL1, 1 to 8), 
ColBIPPd(SL1,1 to 8), ColBIPMn(SL1,1 
to8), ColBIPMd(SL1, 1 to 8). Then, these 
points are converted to drawings

End

A

A
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3.10 The Design Menu: 

This menu is used to run the design mode and to overwrite the design 

factors for column design. 

3.10.1 The Redefine Element Design Data Submenu: 

This submenu is used to define or overwrite the column design factors. It 

displays the Redefine Element Design Data dialog as shown in Figure 3.32 

(form name: RedefineElementDesignData, file: DesignData.frm). In 

this dialog, one can overwrite the values of the unbraced length ratios, 

effective length factors, moment factors Cm, nonsway factors δns , sway 

factors  δs, ratio of dead load to total load βd and element type (see chapter 

two). The program uses the default values of the previous factors. If the 

value in the edit box is other than zero, the program use the value in the 

edit box. 

Figure 3.32 Redefine Element Design Data dialog 

 

The variables that are read from this dialog are defined as follows: 

Element_OvULR33( ): the overwrite value of the unbraced length ratio in 

the major direction. The default value is one. 
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Element_OvULR22( ): the overwrite value of the unbraced length ratio in 

the minor direction. The default value is one. 

Element_OvELF33( ): the overwrite value of the effective length factor in 

the major direction. The default value is one. 

Element_OvELF22( ): the overwrite value of the effective length factor in 

the minor direction. The default value is one. 

Element_OvCm33( ): the overwrite value of the moment factor, Cm in the 

major direction. The default value is that calculated by the program. 

Element_OvCm22( ): the overwrite value of the moment factor, Cm in the 

minor direction. The default value is that calculated by the program. 

Element_OvDns33( ): the overwrite value of the nonsway  factor, δns in 

the major direction. The default value is that calculated by the program. 

Element_OvDns22( ): the overwrite value of the nonsway  factor, δns in 

the minor direction. The default value is that calculated by the program. 

Element_OvDs33( ): the overwrite value of the sway  factor, δs in the 

major direction. The default value is one. 

Element_OvDs22( ): the overwrite value of the sway  factor, δs in the 

minor direction. The default value is one. 

Element_OvBd( ): the overwrite value of the ratio of the factored dead 

load to the factored total load. The default value is that calculated by the 

program. 

Element_Design_Type( ): the column design type: 

 1: sway special moment resisting frame 

 2: sway intermediate moment resisting frame 

 3: sway ordinary moment resisting frame 

 4: nonsway moment resisting frame 
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3.10.2 Start Design/ Show Results: 

This submenu is used to run the design mode. It will be active only if the 

design mode is firstly selected. It displays the Show Design Results dialog 

as shown in Figure 3.33 (form name: DesignOutput, file: 

DesignOutput.frm).  

 

Figure 3.33 Show Design Output dialog  

 

This dialog contains five command buttons. Each one runs a subroutine to 

achieve a specific work. The details of each subroutine will be illustrated 

later.  

The Start Design submenu runs a subroutine for section design (form 

name: MainForm, file: MDIForm.frm) that runs the subroutine 

Element_Design( ) for each element. Figure 3.34 shows the flowchart of 

the main subroutine of this submenu and Figure 3.35 shows the flowchart 

of the subroutine Element_Design ( ). 
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The main variables in the flowchart in Figure 3.35 are defined as follows: 

DesignSBArea= design shear reinforcement bar area 

DesignMBArea= design main reinforcement bar area 

Element_Beam_M33U(I1,I2)= the ultimate beam bending moment for the 

element section I1 and load combination I2 

Element_Beam_V22U(I1,I2)= the ultimate beam shear force for the 

element section I1 and load combination I2 

Element_Beam_T11U(I1,I2)= the ultimate beam torsional moment for the 

element section I1 and load combination I2 

AstMin(I1)= minumn area of steel in a beam section 

Figure 3.34 Flowchart for Start Design/Show Results submenu 

Start

EN>0

I1=1

Subroutine: Element_Design(I1): see the flowchart in 
Figure 3.35 

ENI1<

I1=I1+1 

Yes

End

Yes 
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AsMax(I1)= maximum area of steel in a beam section 

AsTop(I1,I2)= the required area of top steel in beam section in flexure 

design for element section I1 and  load combination I2 

AsBottom(I1,I2)= the required area of bottom steel in beam section in 

flexure design for element section I1 and  load combination I2 

BrTop(I1,I2)= the required top bars in beam section in flexure design for 

element section I1 and  load combination I2 

BrBottom(I1,I2)= the required bottom bars in beam section in flexure 

design for element section I1 and  load combination I2 

BeamAsMaxTop(I1)= maximum area of top steel from all load 

combinations 

BeamAsMaxBottom(I1)= maximum area of bottom steel from all load 

combinations 

BeamVc(I1,I2)= the concrete shear capacity, Vc for beam element section 

I1 and load combination I2 

BeamVs(I1,I2)= the steel shear capacity, Vs for beam element section I1 

and load combination I2 

BeamVn(I1,I2)= the nominal shear capacity, Vn for beam element section 

I1 and load combination I2 

BeamVsMax(I1,I2)= the maximum shear capacity of shear steel, Vs for 

beam element section I1 and load combination I2 

BeamStressA(I1,I2)= the applied stress due to shear and torsion forces on 

beam element section I1 and load combination I2 (needed for checking 

section adequacy for shear and torsion computations) 

BeamStressB(I1,I2)= the capacity stress to resist shear and torsion forces 

on beam element section I1 and load combination I2 (needed for checking 

section adequacy for shear and torsion computations) 
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BeamAvsShear(I1)= the required shear reinforcement for element section 

I1 

BeamAvsTorsion(I1)= the required transverse torsion  reinforcement for 

beam element section I1 

BeamAvsMin(I1)= the minimum transverse reinforcement for beam  

element section I1 

BeamAvsTotal(I1)= the required transverse reinforcement for shear and 

torsion for beam element section I1 

BeamTorsionAl(I1)= the required longitudinal steel for torsion in beam 

element section I1 

BeamTorsionAlmin(I1)= the minimum value of longitudinal steel for 

torsion in beam element section I1 

BeamSpacing(I1)= the required stirrups spacing in beam element section I 

BeamShearEnlargeSection(I1,I2)= identifier for beam section 

enlargement due to shear force. 1: should be enlarged. 2: should not 

BeamTransverseSpacing(I1)= spacing of stirrups in beam section due to 

shear and torsion 

BeamTorsionSteel(I1)= longitudinal steel in beam section due to torsion 

BeamTransverseSteel(I1)= Av/s due to shear and torsion 

BeamShearAvs2(I1)= Av/s due to shear 

BeamTorsionAvs2(I1)= Av/s due to torsion 

Element_Column_F11Uns(I1,I2)= the ultimate axial force due to non 

sway loads for column element I1 and load combination I2 

Element_Column_TopM33Uns(I1,I2)= the ultimate bending moment in 

the major direction at top of column due to non sway loads for element I1 

and load combination I2 
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Element_Column_BottomM33Uns(I1,I2)= the ultimate bending moment 

in the major direction at bottom of column due to non sway loads for 

element I1 and load combination I2 

Element_Column_M33Uns(I1,I2)= the ultimate bending moment in the 

major direction at a point of column height due to non sway loads for 

element I1 and load combination I2 

Element_Column_F11Us(I1,I2)= the ultimate axial force due to sway 

loads for column element I1 and load combination I2 

Element_Column_TopM33Us(I1,I2)= the ultimate bending moment in 

the major direction at top of column due to sway loads for element I1 and 

load combination I2 

Element_Column_BottomM33Us(I1,I2)= the ultimate bending moment 

in the major direction at bottom of column due to sway loads for element I1 

and load combination I2 

Element_Column_M33Us(I1,I2)= the ultimate bending moment in the 

major direction at a point of column height due to sway loads for element 

I1 and load combination I2 

Element_Column_F11U (I1,I2)= the ultimate axial force for column 

element I1 and load combination I2 

Element_Column_TopM33U (I1,I2)= the ultimate bending moment in 

the major direction at top end for column element I1 and load combination 

I2 

Element_Column_BottomM33U (I1,I2)= the ultimate bending moment in 

the major direction at bottom end for column element I1 and load 

combination I2 
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Element_Column_M33U (I1,I2)= the ultimate bending moment in the 

major direction at a point of column height for column element I1 and load 

combination I2 

Betad= the ratio of the factored axial dead load to factored total axial load 

ColumnDesignPcr3(I1,I2)= the critical axial load on column section in the 

major direction 

Column_EnlargeSection(I1,I2)= identifier to enlarge column section. 1: 

the section should be enlarged. 2: should not 

ColumnEnlargeID(I1,I2)= identifier to the cause of column section 

enlargement. 

0: section should not be enlarged 

1: if the ultimate applied axial force is larger than 0.75 Pcr; the 

critical column axial capacity 

3: if the ultimate applied axial force is larger than the column 

maximum axial capacity 

4: if the ultimate applied axial force is less than the column 

maximum tension capacity 

 5: if the biaxial factor is larger than one 

ColumnDesignMu3(I1,I2)= the column design moment in the major 

direction for element I1 and load combination I2 

ColumnDesignPu(I1,I2)= the column design axial force for element I1 

and load combination I2 

ColumnDesignMmin3(I1,I2)= the column design minimum moment in 

the major direction for element I1 and load combination I2 

ColumnDesignCm3(I1,I2)= the column design moment factor, Cm in the 

major direction for element I1 and load combination I2 
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ColumnDesignLu3(I1,I2)= the column design length in the major 

direction for element I1 and load combination I2 

ColumnDesignK3(I1,I2)= the column design effective length  factor, k  in 

the major direction for element I1 and load combination I2 

ColumnDesignDns3(I1,I2)= the column design non sway factor, δns in the 

major direction for element I1 and load combination I2 

ColumnDesignDs3(I1,I2)= the column design sway factor, δs in the major 

direction for element I1 and load combination I2 

ColumnDesignBetad(I1,I2)= the column ratio of factored axial dead load 

to factored total axial load for element I1 and load combination I2 

ColumnDesignAst(I1,I2)= required area of steel in column element I1 and 

load combination I2 

ColumnDesignBars33(I1,I2)= required number of bars in the major 

direction of column element I1 and load combination I2 

ColumnDesignBars22(I1,I2)= required number of bars in the minor 

direction of column element I1 and load combination I2 

ColumnDesignBars (I1,I2)= required number of bars for column element 

I1 and load combination I2 

ColumnDesignRatio(I1,I2)= required steel ratio for column element I1 

and load combination I2 

ColumnDesignBarDiam(I1,I2)= required bar diameter for column 

element I1 and load combination I2 

ColumnDesignPumax(I1,I2)= the design maximum axial load capacity, Pd 

ColumnDesignPumin(I1,I2)= the design minimum axial load capacity, Pt 

ColumnRatio(I1)= required steel ratio for column section element I1 

ColumnBarDiam(I1)= required bar diameter for column section element 

I1 
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ColumnBars33(I1)= required number of bars in the major direction for 

column section element I1 

ColumnBars22(I1)= required number of bars in the minor direction for 

column section element I1 

ColumnBars (I1)= required number of bars for column section element I1 

ColumnAst(I1)= required area of steel for column section element I1 

Element_Column_T11U(I1,I2)= the ultimate torsional moment for 

column element I1 and load combination I2 

Element_Column_V22U(I1,I2)= the ultimate shear force for column 

element I1 and load combination I2 

Element_Column_V22DBU(I1,I2)= the ultimate shear force with 

doubling the seismic loads for column element I1 and load combination I2 

Element_Column_V22USeismic(I1,I2)= the ultimate shear force from the 

seismic loads for column element I1 and load combination I2 

ZeroVc= identifier for Vc=0 if the ultimate seismic shear forces are larger 

than half the total ultimate shear force. 1: Vc=0, 0: Vc does not equal zero  

ColumnTu2(I1,I2)= the torsional moment in major direction for column 

element I1 and load combination I2 

ColumnVu2(I1,I2)= the shear force in major direction for column element 

I1 and load combination I2 

ColumnVp2(I1,I2)= the shear force due to end moment capacities in major 

direction for column element I1 and load combination I2 

ColumnVc2(I1,I2)= the shear force capacity, Vc in major direction for 

column element I1 and load combination I2 

ColumnVs2(I1,I2)= the shear force capacity due to reinforcement in major 

direction for column element I1 and load combination I2 
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ColumnVn2(I1,I2)= the nominal shear force in major direction for column 

element I1 and load combination I2 

ColumnVsMax2(I1,I2)= the maximum shear force due to reinforcement in 

major direction for column element I1 and load combination I2 

ColumnAvsShear2(I1,I2)= the shear reinforcement Av/s  in major 

direction for column element I1 and load combination I2 

ColumnAvsTorsion2(I1,I2)= the torsion reinforcement At/s  in major 

direction for column element I1 and load combination I2 

ColumnAvsMin2(I1,I2)= the minimum shear reinforcement Av/s  in major 

direction for column element I1 and load combination I2 

ColumnAvsTotal2(I1,I2)= the shear and torsion reinforcement Av/s  in 

major direction for column element I1 and load combination I2 

ColumnStressA2(I1,I2)= the shear stress  due to applied shear and torsion 

in major direction for column element I1 and load combination I2 used in 

shear and torsion design  

ColumnStressB2(I1,I2)= the shear stress  due to section capacity in major 

direction for column element I1 and load combination I2 used in shear and 

torsion design  

ColumnAl2(I1,I2)= the torsion longitudinal reinforcement in major 

direction for column element I1 and load combination I2 

ColumnAlmin(I1,I2)= the torsion minimum longitudinal reinforcement in 

major direction for column element I1 and load combination I2 

ColumnTuCapacity2(I1,I2)= the concrete section torsion capacity in 

major direction for column element I1 and load combination I2 

ColumnFSpacing2(I1,I2)= the spacing of stirrups  for shear and torsion in 

major direction for column element I1 and load combination I2 
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ColumnTransverseSpacing2(I1)= the spacing of stirrups in major 

direction for column element I1  

ColumnTransverseSteel2(I1)= the transverse steel Av/s in major direction 

for column element I1  

ColumnShearAvs2(I1)= the transverse steel Av/s due to shear in major 

direction for column element I1  

ColumnTorsionAvs2(I1)= the transverse steel Av/s due to torsion in major 

direction for column element I1  

ColumnTorsionSteel2(I1)= the torsional longitudinal steel in major 

direction for column element I1  

In the minor direction of column, the same variables for shear are used but 

using 3 instead of 2   
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Figure 3.35a Flowchart of the subroutine Element_Design(I1) 

Start

Read the variables: 
Element_Name(I1)= the name found in the elements list 
Element_Section(I1)= Sections_Name(Element_SectionID(I1)) 
Element_Shape(I1)= Sections_Shape(Element_SectionID(I1)) 
Element_Type(I1)= Sections_Type(Element_SectionID(I1)) 
Element_Material(I1)= 
Material_Name(Sections_MaterialID((Element_SectionID(I1))) 
Element_Fc(I1)= 
Material_Fc(Sections_MaterialID((Element_SectionID(I1))) 
Element_Fy(I1)= 
Material_Fy(Sections_MaterialID((Element_SectionID(I1))) 
Element_Fys(I1)= 
Material_Fys(Sections_MaterialID((Element_SectionID(I1))) 
Element_B(I1)= Sections_B(Element_SectionID(I1)) 
Element_H(I1)= Sections_H(Element_SectionID(I1)) 
DesignSBArea=3.14*Element_Design_ShearDiameter(I1)2/400 

Units_ID=Ton_Meter

Fc=Element_Fc(I1)/10      kg/cm2 
Fy=Element_Fy(I1)/10      kg/cm2 
Fys=Element_Fys(I1)/10   kg/cm2 

Fc=Element_Fc(I1)/98.0665      kg/cm2 
Fy=Element_Fy(I1)/98.0665     kg/cm2 
Fys=Element_Fys(I1)/98.0665  kg/cm2

Yes  

Element_Type(I1)=Beam

See Figure 3.35b 
for column 
design A 

Yes



  157
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.35a continued 

A

Read the variables: 
Element_HF=Sections_HF(Element_SectionID(I1)) 
Element_BF=Sections_BF(Element_SectionID(I1)) 
Element_TCover=Sections_Beam_TCover(Element_SectionID(I1)) 
Element_BCover=Sections_Beam_BCover(Element_SectionID(I1)) 
Element_SCover=Sections_Beam_SCover(Element_SectionID(I1)) 
DesignMBArea=3.14*Element_Design_MainDiameter2/400 
B=Element_B(I1)*100   cm 
H=Element_H(I1)*100  cm 
Ds=Element_SCover(I1)*100    cm 
Dt=Element_TCover(I1)*100    cm 
Dc=Element_BCover(I1)*100    cm 

Starting load combination calculations: I2=1

Calculating the ultimate bending moment for the load 
combination: 
N1=1, sum=0

Sum=sum+Element_Beam_M33(I1,N1)*Load_Combinations_Factors(I2,N1) 

5N1≤
Yes

Element_Beam_M33U(I1,I2)=sum

B

B1 
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Figure 3.35a continued 

0I2),am_M33U(I1Element_Be ≥

B

Dc=Element_Bcover(I1)*100  cm 
Dt=Element_TCover(I1)*100  cm 

Dc=Element_Tcover(I1)*100  cm 
Dt=Element_BCover(I1)*100  cm 

Yes

Units_ID= Ton_Meter

I2),am_M33U(I1Element_BeMu =  

80665.9/I2),am_M33U(I1Element_BeMu =  

Yes 

Element_Shape(I1)=Rectangle

Element_HF(I1)=0 
Element_BF(I1)=0 
Rectangle_Section_Design 
Rho_Min

Yes 

CD
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Figure 3.35a continued 

C

sAbd )3/4(min <ρ  

bdρAstMin(I1) min=  sA)3/4(AstMin(I1) =  

Steel_Area 
RhoMax_Rectangle G 

0I2),am_M33U(I1Element_Be ≤

D

F 

Yes 

Yes

Rectangular_Section_Design 
Rho_Min 

sAbd )3/4(min <ρ

bdρAstMin(I1) min=  (4/3)AsAstMin(I1) =  

Yes 

E
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Figure 3.35a  continued 

F

Hf=Element_HF(I1)*100 cm 
Bf=Element_BF(I1)*100 cm 
B=bf 
Compression_Block_Depth

fha ≤  

Rectangular_Section_Design 
Rho_Min 

B=Element_B(I1)*100  cm 
Flanged_Beam_Design 
Rho_Min

Yes

sAd
IBElement

)3/4(100*
*)1(_*min

<
ρ

 

100**)1(
_*AsMin(I1) min

dIB
Elementρ=

 

s(4/3)AAsMin(I1) =

B=Element_B(I1)

Yes  

s

min

(4/3)A
bdρ <

  

bdρAsMin(I1) min=  s(4/3)AAsMin(I1) =  

H

E  

Yes 
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Figure 3.35a  continued 
 

H

Steel_Area 
B=Element_B(I1)*100 cm 
RhoMax_FlangedSection 

dbIAsMax fmax)1( ρ=  

G 

0I2),am_M33U(I1Element_Be ≥

AsTop(I1,I2)=As’ 
AsBottom(I1,I2)=As 
BrTop=As’/DesignMBArea 
BrBottom=As/DesignMBArea 

AsTop(I1,I2)=As 
AsBottom(I1,I2)=As' 
BrTop=As/DesignMBArea 
BrBottom=As'/DesignMBAre

Yes

Start design for shear and torsion for load combination: 
Find Vu, Tu, Pu: 
Sum2=0, sum3=0, sum4=0, N2=1 

Sum2=sum2+Element_Beam_V22(I1,N2)*Load_Combinations_Factors(I2,N2) 
Sum3=sum2+Element_Beam_T11(I1,N2)*Load_Combinations_Factors(I2,N2) 
Sum4=sum2+Element_Beam_F11(I1,N2)*Load_Combinations_Factors(I2,N2) 

52 <N

N2=N2+1 

Yes

I
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Figure 3.35a  continued 

I

Units_ID=Ton_Meter

)2,1(11__

)2,1(11__

)2,1(22__

IIUFBeamElementPu

IIUTBeamElementTu

IIUVBeamElementVu

=

=

=

 

Element_Beam_V22U(I1,I2)=sum2 
Element_Beam_T11U(I1,I2)=sum3 
Element_Beam_F11U(I1,I2)=sum4 

80665.9/)2,1(11__

80665.9/)2,1(11__

80665.9/)2,1(22__

IIUFBeamElementPu

IIUTBeamElementTu

IIUVBeamElementVu

=

=

=

 

gcu AfP '1.0≤  

Shear_Torsion_Design 

J
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Figure 3.35a  continued 

Units_ID=Ton_Meter
Yes  



  164

 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.35a continued 

J

BeamPu(I1,I2)=Pu 
BeamTu(I1,I2)=Tu 
BeamVu(I1,I2)=Vu 
BeamVc(I1,I2)=Vc 
BeamVs(I1,I2)=Vs 
BeamVn(I1,I2)=Vn 
BeamVsMax(I1,I2)=ShearCapacityB 
BeamStressA(I1,I2)=StressA 
BeamStressB(I1,I2)=StressB 
BeamTuCapacity(I1,I2)=Tmin 

BeamPu(I1,I2)=Pu*9.80665 
BeamTu(I1,I2)=Tu*9.80665 
BeamVu(I1,I2)=Vu*9.80665 
BeamVc(I1,I2)=Vc*9.80665 
BeamVs(I1,I2)=Vs*9.80665 
BeamVn(I1,I2)=Vn*9.80665 
BeamVsMax(I1,I2)=ShearCapacityB*
9.80665 
BeamStressA(I1,I2)=StressA*9.80665 
BeamStressB(I1,I2)=StressB*9.80665 
BeamTuCapacity(I1,I2)=Tmin* 
9.80665 

BeamAvsShear(I1,I2)=AvOverSReqSh 
BeamAvsTorsion(I1,I2)=AtOverS*2 
BeamAvsMin(I1,I2)=3.5b/fys 
BeamAvsTotal(I1,I2)=AvtOverS 
BeamTorsionAl(I1,I2)=LongSteel 
BeamTorsionAlmin(I1,I2)=Almin 
BeamSpacing(I1,I2)=Spacing 

112 <I I2=I2+1 

B1 

Yes 

L

L

Find the maximum design values from the 
load combinations: 
BeamAsMaxTop(I1) 
BeamAsMaxBottom(I1) 
BeamTransverseSpacing(I1) 
BeamTorsionSteel(I1) 
BeamTransverseSteel(I1) 
BeamShearAvs2(I1) 
BeamTorsionAvs2(I1) 
Give notes if: 
BeamShearEnlargeSection(I1,I2)=1 or 
BeamTorsionEnlargeSection(I1,I2)=1 that the 
section should be enlarged
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From Figure 3.35a

Read variables: 
Element_Cover(I1)= 
Sections_Column_Cover(Element_SectionID(I1)) 
Element_Column_Length(I1)= 
Sections Column Length(Element SectionID(I1))
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Figure 3.35b flowchart of the subroutine Element_Design(I1), 
column design for axial and bending 
 

Figure 3.35b continued 

Design for axial and bending in the major 
direction of column: 
Dc=Element_Cover(I1) 
B=Element_B(I1)*100  cm 
H=Element H(I1)*100  cm

Starting load combinations: 
I2=1

Element_OvULR33(I1)=0

Lu=Element_Column_Length(I1)*
100 

Lu=Element_Column_Length(I1)*
100*Element_OvULR33(I1) 

Yes 

Element_OvELF33(I1)=0

K=1 K=Element_OvELF33(I1) 

Yes 

A

A

Element_OvDs33(I1)=0

Yes 
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Figure 3.35b continued 

1=sδ  )1(33_ IOvDsElements =δ

Element_Design_Type(I1)= 
1,2,3

CheckSway=1 CheckSway=0 

Yes 

Find nonsway loads ( from load combinations 1,2): 
Sum1=0, sum2=0, sum3=0, sum4=0, N1=1 

Sum1=sum1+Element_Column_F11(I1,N1)*Load_Combinations_Factors(I2,N1) 
Sum2=sum2+Element_Column_TopM33(I1,N1)*Load_Combinations_Factors 
(I2,N1) 
Sum3=sum3+Element_Column_BottomM33(I1,N1)*Load_Combinations_Factors 
(I2,N1) 
Sum4=sum4+Element_Column_M33(I1,N1)*Load_Combinations_Factors(I2,N1) 

21<N
N1=N1+1 Yes

B

B

Element_Column_F11Uns(I1,I2)=sum1 
Element_Column_TopM33Uns(I1,I2)=sum2 
Element_Column_BottomM33Uns(I1,I2)=sum3 
Element_Column_M33Uns(I1,I2)=sum4
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Figure 3.35b continued 

Find sway loads (from load combinations 3,4,5): 
Sum1=0, sum2=0, sum3=0, sum4=0, N1=3 

Sum1=sum1+Element_Column_F11(I1,N1)*Load_Combinations_Factors(I2,N1) 
Sum2=sum2+Element_Column_TopM33(I1,N1)*Load_Combinations_Factors 
(I2,N1) 
Sum3=sum3+Element_Column_BottomM33(I1,N1)*Load_Combinations_Factors 
(I2,N1) 
Sum4=sum4+Element_Column_M33(I1,N1)*Load_Combinations_Factors(I2,N1) 

51<N
N1=N1+1 Yes 

Element_Column_F11Us(I1,I2)=sum1 
Element_Column_TopM33Us(I1,I2)=sum2 
Element_Column_BottomM33Us(I1,I2)=sum3 
Element_Column_M33Us(I1,I2)=sum4

Total ultimate loads: 
Element_Column_F11U(I1,I2)= Element_Column_F11Uns(I1,I2)+ 
Element_Column_F11Us(I1,I2)  
Element_Column_TopM33U(I1,I2)= Element_Column_TopM33Uns(I1,I2)+ 
Element_Column_TopM33Us(I1,I2)  
Element_Column_BottomM33U(I1,I2)= 
Element_Column_BottomM33Uns(I1,I2)+ 
Element_Column_BottomM33Us(I1,I2)  
Element_Column_M33U(I1,I2)= Element_Column_M33Uns(I1,I2)+ 
Element_Column_M33Us(I1,I2)  

C

C

Element_OvBd(I1)=0

Element_Column_F11U(I1,I2)<>0

Beatd=Element_OvBd(I1)  > = 0.0

Yes 

Betad=0Betad={Element_Column_F11(I1,1)* 
Load_Combination_Factors(I2,1)}/ 
Element_Column_F11U(I1,I2)  > = 0.0 

Yes

Find the moment factor, Cm: 
ColumnM1= Element_Column_TopM33U(I1,I2) 
ColumnM2= Element_Column_BottomM33U(I1,I2) 
ColumnMspan= Element_Column_M33U(I1,I2) 

ColumnM2ColumnM1 ≥  

ColumnMmax=ColumnM1ColumnMmax=ColumnM2

Yes

D
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Figure 3.35b continued 

Element_Column_SpanMoments
(I1)=1 ‘having  span moments’ 

Yes

Yes 
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Figure 3.35b continued 

D

ColumnMmax

nColumnMspa >
 

ColumnCm=1 Column_Cm 

Element_Column_SpanLoads
(I1) =1 ‘having span loads’ 

ColumnCm=1 Column_Cm 

Yes 

Element_OvCm33(I1)<>0

ColumnCm=Element_OvCm33(I1) 

Yes 

E

E

Find section critical axial load, Pcr: 
Column_Pcr 

Units_ID= Ton_Meter

ColumnDesignPcr3(I1,I2)=Pcr 
Pu=Element_Column_F11U (I1,I2) 

ColumnDesignPcr3(I1,I2)=Pcr* 
9.80665 
Pu=Element_Column_F11U 
(I1,I2)/ 9.80665 

Yes 

cru PP 75.0≥ 

Column_EnlargeSection 
(I1,I2)=1 
Column_EnlargeID 
(I1,I2)=1

Column_EnlargeSection 
(I1,I2)=0 
Column_EnlargeID 
(I1,I2)=0

Column_DeltaNs1

Element_OvDns33(I1)=0

DeltaNsF=DeltaNs1 DeltaNsF=Element_OvDns33(I1)

F

Yes 
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Figure 3.35b continued 

F

Start finding the design 
moment. Units_ID= 
Ton_Meter 

Element_Column_SpanMoments
(I1)=1

Yes

CheckSway= 0

Yes 

ColumnMu= Element_Column_M33U(I1,I2) 

Yes 

ColumnMu=Element_Column_M33U(I1,I2) 
ColumnMuNs=Element_Column_M33Uns(I1,I2) 
ColumnMuS=Element_Column_M33Us(I1,I2)

CheckSway=0

ColumnMu=ColumnMmax 
Column_Mc 
ColumnMDesign=ColumnMc 

L 

G

I 
Yes

H 
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Figure 3.35b continued 

I

Column_Mc 
ColumnMDesign=ColumnMc 

H

ColumnMu=ColumnMmax 
ColumnMuNs=Element_Column_TopM33Uns(I1,I2) 
ColumnMuS=Element_Column_TopM33Us(I1,I2) 
Column_Mc 
ColumnMDesign=ColumnMc 
ColumnMuNs=Element_Column_BottomM33Uns(I1,I2) 
ColumnMuS=Element_Column_BottomUs(I1,I2) 
Column_Mc 

ignColumnMDesColumnMc >  

ColumnMDesign=ColumnMc 

Yes 

ignColumnMDesMux =  

CheckSway=0

H1H2 

Yes
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Figure 3.35b continued 

H1

H2 

( )100/03.0015.0 hPuMux +<  

( )100/03.0015.0 hPuMux +=  

Yes

ColumnDesignMu3(I1,I2)=Mux 
ColumnDesignPu(I1,I2)=Pu 
ColumnDesignMmin3(I1,I2)= 

( )100/03.0015.0 hPu +  

The same procedure as for 
Ton_Meter units. 

G 

ColumnDesignCm3(I1,I2)=ColumnCm 
ColumnDesignLu3(I1,I2)=Lu 
ColumnDesignK3(I1,I2)=Kfactor 
ColumnDesignDns3(I1,I2)=DeltaNsF 
ColumnDesignDs3(I1,I2)=DeltaSF 
ColumnDesignBetad(I1,I2)=Betad

K
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Figure 3.35b continued 

K

In the minor direction: 
B=Element_H(I1)*100  cm 
H=Element_B(I1)*100  cm 
The previous steps are to be done for the load combination I2. The 
number 3 is to be converted to 2 that indicates the minor direction. 

Units_ID=Ton_Meter

ColumnDesignMu2(I1,I2)=Muy 
ColumnDesignPu(I1,I2)=Pu 
ColumnDesignMmin2(I1,I2)= 

( )100/03.0015.0 hPu +  

ColumnDesignMu2(I1,I2)=Muy* 
9.80665 
ColumnDesignPu(I1,I2)=Pu* 9.80665 
ColumnDesignMmin2(I1,I2)= 

( )100/03.0015.0 hPu +

ColumnDesignCm2(I1,I2)=ColumnCm 
ColumnDesignLu2(I1,I2)=Lu 
ColumnDesignK2(I1,I2)=Kfactor 
ColumnDesignDns2(I1,I2)=DeltaNsF 
ColumnDesignDs2(I1,I2)=DeltaSF

ColRmin: minimum steel ratio >0.0 
ColRmax: maximum steel ratio <= 0.08 
For Element_Design_Type(I1,I2)=1 
‘special’, ColRmax < =  0.06 
Start designing the section for Pu, 
Mux, Muy

O
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Figure 3.35b continued 

O

Element_Design_Reinforcement_ 
Type(I1)=1 ‘given bars 
configuration’ 

D4 
Yes

ColRho=ColRmin

In major direction: 
H=Element_H(I1)*100  cm 
B=Element_B(I1)*100  cm 
BarsH=Element_Design_Column_Bars33(I1) 
BarsB=element Design Column Bars22(I1)

D2 

Column_MinBars 
Column_Design_Given_BarsArrangement 
Column_ReinforcementRow_Area_Depth 
Column_Pmin 
Column_Balanced_Condition 
Ultimate_Axial_Capacity 
Tension_AxialCapacity 
ColumnDesignPumax(I1,I2)=PD1 
ColumnDesignPumin(I1,I2)= -PUTenD

P
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Figure 3.35b continued 

P

0≥Pu

1PDPu >  PUTenDPu <  

D1 

Yes

Find Ф 
Pn=Pu/Ф 
Column_Mo 
PhiMnx=ФMn

In the minor direction: 
B=Element_H(I1)*100  cm 
H=Element_B(I1)*100 cm 
BarsH=Element_Design_Column_Bars22(I1) 
BarsB=Element_Design_Column_Bars33(I1) 
Column_MinBars 
Column_Design_Given_BarsArrangement 
Column_ReinforcementRow_Area_Depth 
Column_Pmin 
Column_Balanced_Condition 
PUCN1=Pu/PhiCompression 
Phi_Column 
Pn=Pu/Ф 
Column_Mo 
PhiMny= ФMn 

Q
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Figure 3.35b continued 

Q

Column_Biaxial_Factor

1≤torBiaxialFac

ColRho=ColRho+0.001

D1 

maxColRColRho ≤

Yes 

D2

Yes  

ColumnDesignBiFactor(I1,I2)=BiaxialFactor

0≥Pu

1PDPu >  

Yes

Column_EnlargeSection(I1,I2)=1 
ColumnEnlargeID(I1,I2)=3 

Yes 

D3

Column_EnlargeSection(I1,I2)=0 
ColumnEnlargeID(I1,I2)=0 

R1 R2 
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Figure 3.35b continued 

R1

PuTenDPu −<

Column_EnlargeSection(I1,I2)=1 
ColumnEnlargeID(I1,I2)=4 

Yes 

D3 

Column_EnlargeSection(I1,I2)=0 
ColumnEnlargeID(I1,I2)=0 

R1 

BiaxialFactor>1

Column_EnlargeSection(I1,I2)=1 
ColumnEnlargeID(I1,I2)=5 

Column_EnlargeSection(I1,I2)=0 
ColumnEnlargeID(I1,I2)=0 

Yes 

Column_EnlargeSection(I1,I2)=1

Note: Enlarge section, 
go to the end of the 
subroutine

Yes  

S
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Figure 3.35b continued 

S

ColumnDesignAst(I1,I2)= AstTotal 
ColumnDesignBars33(I1,I2)=Element_Design_Column_
Bars33(I1) 
ColumnDesignBars22(I1,I2)=Element_Design_Column_
Bars22(I1) 
ColumnDesignBars(I1,I2)=2*ColumnDesignBars33(I1,I
2)+2*(ColumndesignBars22(I1,I2)-2) 
ColumnDesignRatio(I1,I2)=ColumnDesignAst(I1,I2)/bh 
ColumnDesignBarDiam(I1,I2)= 

1416.3*)2,1(
400*)2,1(

IIgnBarsColumnDesi
IIgnAstColumnDesi

  

D5 

D4

For the given bar diameter, it is required to 
obtain bars configuration (distribution) 
ColRho=ColRmin

D7 

In the major direction: 
H=Element_H(I1)*100 cm 
B=Element_B(I1)*100 cm 
BarArea=3.1416*Element_Design_MainDiameter(I1)2/400 

T
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Figure 3.35b continued 

T 

Column_Design_Given_BarDiam 
Dbars33=BarsH 
Dbars22=BarsB 
Column_ReinforcementRow_Area_Depth 
Column_Pmin 
Column_Balanced_Condition 
Ultimate_Axial_Capacity 
Tension_AxialCapacity 
ColumnDesignPumax(I1,I2)=PD1 
ColumnDesignPumin(I1,I2)= -PUTenD 

0≥Pu 

Pu>PD1 

D6 

Pu<-PDTenD 

D6

Yes

Yes Yes

PUCN1=pu/Ф 
Phi_Column 
Pn=Pu/Ф 
Column_Mo 
PhiMnx=ФMn

In minor direction: 
H=Element_B(I1)*100  cm 
B=Element_H(I1)*100  cm 
Temp=BarsH, BarsH=Barsb, BarsB=Temp 
Column_MinBars 
Column_Design_Given_BarDiam 
Column_ReinforcementRow_Area_Depth 
Phi_Column, Pn=Pu/Ф 
Column_Mo 
PhiMny=ФMn

U
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Figure 3.35b continued 

U

Column_Biaxial_Factor

1≤torBiaxialFac

ColRho=ColRho+0.001

maxColRColRho≤  

D6 

D7 Yes 

Yes 

ColumnDesignBiFactor(I1,I2)=BiaxialFactor

0≥Pu
Pu>PD1

Column_EnlargeSection(I1,I2)=1 
ColumnEnlargeID(I1,I2)=3 

Column_EnlargeSection(I1,I2)=0 
ColumnEnlargeID(I1,I2)=0 

Yes 

Yes

Pu<-PUTenD

Column_EnlargeSection(I1,I2)=1 
ColumnEnlargeID(I1,I2)=4 

Column_EnlargeSection(I1,I2)=0 
ColumnEnlargeID(I1,I2)=0 

D9W D8

Yes 
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Figure 3.35b continued 

W

BiaxialFactor>1

Column_EnlargeSection(I1,I2)=1 
ColumnEnlargeID(I1,I2)=5 

Column_EnlargeSection(I1,I2)=0 
ColumnEnlargeID(I1,I2)=0 

Yes 

D9 

Column_EnlargeSection(I1,I2)=1

Note: enlarge section, go to 
end of subroutine 

Yes  

ColumnDesignBars33(I1,I2)=Dbars33 
ColumnDesignBars22(I1,I2)=Dbars22 
ColumnDesignBars)I1,I2)=2*Dbars33+2*(DBars22-2) 
ColumnDesignAst(I1,I2)=ColumnDesignBars(I1,I2)*BarArea 
ColumnDesignBarDiam(I1,I2)=Element_Design_MainDiameter(I1,I2) 
ColumnDesignRatio(I1,I2)=ColumnDesignAst(I1,I2)/bh

112<I I2=I2+1
Yes 

C0 

If Column_EnlargeSection(I1,I2) =1 for any load combination, 
enlarge section. Go to the end of subroutine. 
Find the maximum values from the all load combinations: 
ColumnRatio(I1) 
ColumnBars33(I1) 
ColumnBars22(I1) 
ColumnBarDiam(I1) 
ColumnBars(I1) 
ColumnAst(I1) 

To Figure 3.35c: design column section 
for shear and torsion
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Figure 3.35c Flowchart of the subroutine 
Element_Design(I1), design for shear and torsion 

From Figure 3.35b

Start finding Vp from end moment capacities: 
DesignMBArea=3.1416*Element_Design_MainDiameter(I1)2/400 

Element_Design_Type(I1)=1 
‘special’

Units_ID=Ton_Meter

Fy=1.25*Element_Fy(I1)/10 Fy=1.25*Element_Fy(I1)/98.06
65 

Yes 

Yes 

Units_ID=Ton_Meter

Fy=Element_Fy(I1)/10 Fy=Element_Fy(I1)/98.0665

Yes 

Starting load combinations calculations: 
I2=1 

Ucheck(I1,I2)=1

A  F1 

Yes
H1 
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Figure 3.35c continued 

A

Column_EnlargeSection(I1,I2)=1

To the end of subroutine 

StirrupsArea=DesignSArea*2 
Sum1=0 

N2=1

Sum1=sum1+Element_ColumnT11(I1,N2)*Load_Combinations_Factors(I2,N2) 

52 <N N2=N2+1 
Yes

Yes 

Element_Column_T11U(I1,I2)=sum1

In major direction: 
Sum1=0, N1=1

Sum1=sum1+Element_ColumnV22(I1,N2)*Load_Combinations_Factors(I2,N1) 

21<N N1=N1+1

Shear from gravity loads: 
Element Column V22DLU(I1,I2)=sum1

B

Yes 
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 Figure 3.35c continued 

B

Sum1=0, N1=1

Sum1=sum1+Element_Column_V22(I1,I2)*Load_Combinations_Factors(I2,N1) 

51<N N1=N1+1

Yes 

Ultimate shear: 
Element_Column_V22U(I1,I2)=sum1 

Element_column_V22Useismic(I1,I2)=Element_Column_V22(I1,3)* 
Load_Combinations_Factors(I2,3) 
Element_Column_V22DBU(I1,I2)= 
Element_Column_V22U(I1,I2)+Element_Column_V22USeismic 

B=Element_B(I1)*100  cm 
H=Element_H(I1)*100 cm 
BarsB=ColumnBars22(I1) 
BarsH=ColumnBars33(I1) 
BarArea=ColumnAst(I1)/Colu
mnBars(I1)

C
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Figure 3.35c continued 

C

Units_ID=Ton_Meter

Pn=Element_Column_F11U(I1,I2) 
Pn=Element_Column_F11U(I1,I2)/ 
9.80665 

Yes 

Element_Design_Type(I1)=1

ZeroVc=0 

10000/'
)2,1(11__

)2,1(22__5.0

)2,1(22__

bhf
IIUFColumnElement

andIIUVColumnElement

IIUSeismicVColumnElement

c

<

>

 

ZeroVc=1 ZeroVc=0 

Yes  

Column_ReinforcementRow_Area_Depth 
Column_Mo 
Vp=2Mn/Element_Column_Length(I1) 

D
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 Figure 3.35c continued 

D

Units_ID=Ton_Meter

As done for the Ton_Meter units, 
but converting to 
kilonewton_Meter 

Yes 

Element_Design_Type(I1)=1

Vu=Element_Column_V22U(I1,I2) 
ColumnDesignVp(I1,I2)=Vp 

Yes  

Vu

IIDLUV
ColumnElement

Vp

>

+
)2,1(22

__
 

ColumnDesignVu(I1,I2)=Vp+ 
)2,1(22__ IIDLUVColumnElement  

Yes 

ColumnDesignVu(I1,I2)= Vu  

F

F 

F7  
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 Figure 3.35c continued 

F

Element_Design_Type(I1,I2)=2

Vu=Element_Column_V22DBU(I1,I2) 
ColumnDesignVp(I1,I2) 

Yes 

Vu=Element_Column_V22U(I1,I2) 
ColumnDesignVp(I1,I2)=0 
ColumnDesignVu(I1,I2)= Vu  

Vu

IIDLUVColumnElementVp

<

+ )2,1(22__
 

ColumnDesignVu(I1,I2)=Vp+ 
)2,1(22__ IIDLUVColumnElement

Yes  

ColumnDesignVu(I1,I2)=  
Vu  

Units_ID=Ton_Meter

Fy=Element_Fy(I1)/10 Fy=Element_Fy(I1)/98.0665 

Yes  

K
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Figure 3.35c continued 

K

Vu=ColumnDesignVu(I1,I2) 
Pu=Element_Column_F11U(I1,I2) 
Tu=Element_Column_T11U(I1,I2) 
Shear_Torsion_Design

Output values for shear in major direction of column: 
ColumnTu2(I1,I2)=Tu 
ColumnVu2(I1,I2)=Vu 
ColumnVp2(I1,i2)=ColumnDesignVp(I1,I2) 
ColumnVc2(I1,I2)=Vc 
ColumnVs2(I1,I2)=Vs 
ColumnVn2(I1,I2)=Vn 
ColumnVsmax2(I1,I2)=ShearCapacityB 
ColumnAvsShear2(I1,I2)AvsOverSReqSh 
ColumnAvsTorsion2(I1,I2)=AtOverS 
ColumnAvsMin2(I1,I2)=3.5b/fys 
ColumnAvsTotal2(I1,I2)=AvtOverS 
ColumnStressA2(I1,I2)StressA 
ColumnStressB2(I1,I2)=StressB 
ColumnShearEnlargeSection2(I1,I2)=Check_Shear_EnlargeSection 
ColumnTorsionEnlargeSection2(I1,I2)=Check_Enlarge_Section_Torsion 
ColumnTorsionAl2(I1,I2)=LongSteel 
ColumnTorsionAlmin2(I1,I2)=AlMin 
ColumnTuCapacity2(I1,I2)=Tmin 
ColumnFSpacing2(I1,I2)=Spacing 

Element_Design_Type(I1,I2)
<>1,2

F7  

Q  M
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Figure 3.35c continued 

M

16ColumnBarDiam(I1)/10 
<Element_B(I1)*100

ColumnTiesSpacing2B(I1)=  
16ColumnBarDiam(I1)/10 

ColumnTiesSpacing2B(I1)=  
Element_B(I1)*100 

Yes  

Ties spacing: 

ColumnTiesSpacing2B(I1)> 
48Element_Design_ 
ShearDiameter(I1)/10

ColumnTiesSpacing2B(I1)=48Element_Design_ShearDiameter(I1)/10 

Yes 

W

Q

Element_B(I1)<Element_H(I1)

N  L 

L16ColumnBarDiam(I1)< 
Element_B(I1)*100
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Figure 3.35c continued 

ColumnTiesSpacing2B(I1)= 
16ColumnBarDiam(I1)/10 

ColumnTiesSpacing2B(I1)= 
Element_B(I1)*100 

16ColumnBarDiam(I1)/10 
<Element_H(I1)*100

N 

ColumnTiesSpacing2B(I1)= 
16ColumnBarDiam(I1)/10 

ColumnTiesSpacing2B(I1)= 
Element_H(I1)*100 

Yes 

Yes 

ColumnTiesSpacing2B(I1)>48 
Element_Design_ShearDiameter(I1)/10

ColumnTiesSpacing2B(I1)= 
48Element_Design_ShearDiameter(I1)/10 

Yes

Element_B(I1)<Element_H(I1)

T S 
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Figure 3.35c continued 

T

Yes 
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Figure 3.35c continued 

10 cm<0.25Element_B(I1)*100

ColumnTiesSpacing2A(I1)=10 ColumnTiesSpacing2A(I1)= 
0.25Element B(I1)*100 

S

10 cm<0.25Element_H(I1)*100

ColumnTiesSpacing2A(I1)=10 ColumnTiesSpacing2A(I1)= 
0.25Element_H(I1)*100 

ColumnTiesSpacing2B(I1) 
<ColumnTiesSpacing2A(I1)

ColumnTiesSpacing(I1)= 
ColumnTiesSpacing2B(I1) 

ColumnTiesSpacing(I1)=  
ColumnTiesSpacing2A(I1) 

W

W

Output for design of column section in major direction: 
If ColumnShearEnlargeSection(I1,I2) =1 or 
ColumnTorsionEnlargeSection(I1,I2)=1: indication to enlarge 
section. 
Maximum values of load combinations: 
ColumnTransverseSpacing2(I1) 
ColumnTorsionSteel2(I1) 
ColumnTransverseSteel2(I1) 
ColumnShearAvs2(I1) 
ColumnTorsionAvs2(I1) 

In the minor direction: 
The same procedure is done as for the major direction. The 
main differences are: 
B=Element_H(I1)*100 cm 
H=Element_B(I1)*100 cm 
BarsB=ColumnBars33 
BarsH=ColumnBars22 
Use the numbers 33 instead of 22 in the variables 
Use the number 3 instead of 2 in the variables End



  194
 
 



  1

Chapter One 
Introduction 

1.1 Computer Programs and Structural Engineering: 

The structural design process consists of three general phases: conceptual 

design, preliminary design and final design. In the conceptual design phase, 

the structural system for a particular structure is selected. Often more than 

one system needs to be worked out in order to compare them on the basis 

of cost, functionality and other important criteria. In case of most buildings, 

the architect is usually the decision-maker; but he or she is well advised to 

consult with the structural engineer from the very beginning of the 

conceptual design phase. 

In the preliminary design phase, most of the specific structural design 

parameters (such as floor heights, column spacings, and beam and column 

cross sections) are selected if they have not been determined in the 

conceptual design phase. In order to design the structure, we need to know 

the forces and moments for which to design it. However, some of these 

forces and moments (e.g. those due to dead load) are not known until the 

structure has been designed. This dilemma is worsened in the case of 

statically indeterminate structures, because the analysis cannot be 

performed unless the individual member stiffness is known beforehand, in 

addition to the loads. This dilemma is resolved by the step-by-step 

procedure outlined schematically in Figure 1.1.  

This procedure can be reduced by experienced engineers. Experienced 

designers have the added advantage of having access to a number of 

previous designs. The structural analysis is typically done with the help of 

computers, since powerful computers are now standard equipment in 
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design offices and engineering colleges and user-friendly, efficient, and 

versatile structural analysis programs are widely available. 

After analysis, the design process begins. Each element section should be 

designed to compute the area of steel for the applied forces. If the sections’ 

dimensions are satisfactory, the design process will finish. If not, the 

sections will be redesigned and then structural analysis should be made. 

This procedure is repeated until the sections’ dimensions are enough.  

 

 

 

 

 

No  

Yes 

Figure 1.1 The design_analysis cycle

Preliminary design

Structural analysis

Design 
OK 

Stop 

Redesign 
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From the previous discussion, it is obvious that the analysis and the design 

processes are long. They need a quick method or way to achieve them. 

Computer programs are very important in these processes. There should be 

computer programs for structural analysis, section design and section 

evaluation.  

Section design is very important in the design process. Usually the design 

should be controlled with a code of practice. The computer programs 

should cover the requirements of the design theory and the referred code of 

practice.  

Computer programs for analysis (evaluation) and design of reinforced 

concrete sections are very important in the design process and in evaluating 

sections and members in existing structures.  The design of the section is to 

compute the required areas of steel for the applied forces like bending 

moments, shear forces, axial forces and torsional moments. The required 

areas of steel are to be computed for a trial section from conceptual or 

preliminary design phases. Also, there is a need to distribute the 

reinforcement steel through the section for practical use.  

Evaluating reinforced concrete section is to determine its capacity for 

bending, shear, axial and torsion. Interaction diagrams are needed for 

column section design and evaluation. Evaluating the element section is 

very important in studying and evaluating existing structures. Beam, 

column and footing capacities should be determined to check the structure 

strength.  
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1.2 Arabic Structural Engineering Programs: 

The most popular structural engineering programs are of English language. 

Structural engineers in the Arabic world and also in our country, Palestine, 

studied the engineering courses in universities in English language, some of 

them in other languages like Russian, French and Arabic. 

A nation can build its civilization using only its language. The nation can 

take benefits from other languages in civilization styles, but the own 

language should be the basic of civilization. 

There is a need to have Arabic structural computer programs in order to 

have a common language between the whole engineers and to build our 

own civilization. 

1.3 Available Programs for Analyzing and Designing of Reinforced 

Concrete Sections: 

There are many computer programs dealing with reinforced concrete. 

Popular computer programs like SAP2000, STAAD and others are 

structural analysis and design programs. These programs have the ability to 

analyze the structural model and then design the sections to the applied 

forces. Other programs like PROKON  have the ability of section design 

for input values of forces. Torsion is neglected in most of these programs 

but recently considered in SAP2000, version 8. There is no available 

program that has the ability of section analysis (evaluation) and section 

design for the user input data of different loads especially torsion, and in 

the same time it is in Arabic language and has the ability of producing 

section reinforcement layout and interaction diagrams for number of 

sections at the same time.  
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1.4 The Importance of the Program 

The program AD RCS is able to analyze and design reinforced concrete 

beam and column sections for bending, shear, axial and torsion. For the 

analysis: the section dimensions, material properties, and the existing 

reinforcement should be entered and the section capacities will be found. 

For design: the preliminary section dimensions, material properties and the 

applied forces should be entered and the needed reinforcement will be 

found. For the beam section analysis, the moment, shear and torsional 

capacities are calculated. Also the axial force_shear force interaction 

diagram is displayed. For the column section analysis, interaction diagrams 

for axial forces_ shear forces and axial forces_bending moments in the two 

directions are displayed. For beam section design, the required 

reinforcement is calculated for the applied forces of bending, axial, shear 

and torsion. For column section design, the required steel is calculated for 

the applied forces in the two directions. In addition, interaction diagrams 

for axial, shear and bending are displayed. For the footing analysis, the 

single footing column axial capacity is calculated. For footing design, the 

footing dimensions and reinforcement are calculated. The program 

produces reinforcement section details for the design of a beam, a column 

and a single footing. All the output data can be printed including the tables 

and the interaction diagrams. The program gives summarized tables for the 

analysis and design output in addition to detail sheets.  The user can enter 

up to 50 sections at the same time and gets the results after. During the 

input time, the user can change any data he enters. Also, it is possible to 

change bar diameters of reinforcement steel in section design and the 

program develops a new section detail for the new bar diameters. The 
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program supports all the ACI 318-99 load combinations and the user can 

change the combination factors.  

The program is introduced in Arabic and English languages and in 

ton.meter and kelonewton.meter (SI) units. 

This program is designed to help students in structural engineering courses 

especially in their projects. The student spends much time on drawing 

interaction diagram for one column, calculating areas of steel for bending 

in beams, for shear calculations …etc. The program helps him to achieve 

these calculations and he will have time for system creation. The program 

will help the engineers in the engineering offices. They can use it for 

design of forces especially the design for torsion. The program is very 

important in section evaluation for failure analysis projects; the section 

capacity will be determined.   

1.5 Programming Language and Style 

The program is constructed by using Visual Basic 6 programming 

language. This language is practical, quick and powerful.  

The program is displayed with forms or dialog boxes and needs Windows 

for running, as it is the case for all the available visual programs. The input 

and output data are displayed in dialog boxes by edit boxes, options, lists, 

tables and graphs. There would be main menu and quick buttons to deal 

with the user.  

In Visual Basic, each dialog box or form has a code page and they are 

found in a file. Also, the common data or subroutines can be written in 

code files that called Modules. So, the visual basic program or project 

consists mainly of many files; forms and modules.  
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1.6 The Thesis Composition: 

The thesis is constructed in six chapters. Chapter one illustrated the 

program importance and the existing computer programs. Chapter two 

illustrates the theory basics of analysis and design of reinforced concrete 

sections; beams, rectangular columns and single footings. It introduces the 

main steps of section analysis and design and the flowcharts of the program 

subroutines using the common symbols of variables and the same names of 

the program subroutines. The analysis and design steps are divided to 

smaller units to be used in the subroutines, as they are many steps that are 

repeated in analysis or design of different sections. Chapter three illustrates 

the program composition. It introduces the flowcharts of the program 

menus, definition of variables used in the program code and the dialog 

boxes forms with names of files. Chapter four introduces quick tutorials or 

examples illustrate the steps of using the program. Chapter five illustrates 

the main steps of using the program. It illustrates the steps for defining 

materials, sections, load cases, forces and reinforcement.  Chapter six 

introduces problems that are solved manually and by the program. Chapter 

seven introduces remarks and recommended future studies. 
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Chapter Seven 
Remarks and Recommended Future Works 

Programming is very important in engineering. Today, the programming 

languages are developed and widespread. These programming languages 

should be learned and used for constructing local and international 

programs that are needed to develop the engineering fields and especially 

to develop the local programming field. Local programs will be appropriate 

to local specifications and practice and also they will be cheaper. 

Programming companies should be established, as they are many local 

programmers in order to develop the scientific and economic national 

fields. 

The program AD RCS (Analysis and Design of Reinforced Concrete 

Sections) can be considered as a step in the local engineering 

programming. This program is constructed in a master thesis, that is a work 

of one person. This program will be developed in the future and will 

stretched to have other many abilities such as the addition of other types of 

footings like combined and wall footings, other shapes of sections like I 

sections and more international units like pound and inch.   
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Chapter Five 
Getting Started with the Program 

In this thesis, a computer program will be introduced as a result of a very 

hard work. The program will have the ability of evaluating and designing 

reinforced concrete sections of beam, column and single footing. Also, the 

program has the ability of introducing axial force-bending moment 

interaction diagrams for the column section and details for section design 

of beam, column and single footing. 

5.1 Evaluating (analyzing) Reinforced Concrete Sections: 

The program has the ability of analyzing reinforced concrete sections of 

beams, columns and single footing. 

Beam Section: The material property is defined by entering the values of 

the compressive strength of concrete, fc’, longitudinal steel yield strength, 

fy and transverse steel yield strength, fys’. The user defines the section 

dimensions; width and height of rectangular section or the width, height, 

flange width and flange thickness for a T and L sections.. The existing 

reinforcement is defined for the top, bottom and shear reinforcement. The 

program gives the moment capacities for the positive and negative 

moments and the design shear capacity. The torsion capacity for section is 

also introduced for concrete. Also, the program gives interaction diagram 

that relates the axial force capacity and the shear capacity in the major 

direction of the section. The axial load is limited to 0.1fc’Ag (Ag is the 

section cross-area). The beam theory is applied to axial load maximum of 

0.1fc’Ag.  
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Column Section: the user defines the rectangular section dimensions; 

width and height. The material property is also defined by entering the 

values of fc’, fy, and fys. The existing reinforcement is defined as the 

number of longitudinal bars and bars distribution and the shear 

reinforcement. The program gives the interaction diagrams that relates the 

axial force capacity and the bending moment capacity in the major and 

minor directions. Also, the program gives interaction diagrams that relates 

the axial load capacity and the shear capacity and concrete torsion capacity 

in the major and minor directions.  

Footing: the user defines the column dimensions and the material 

properties. The footing dimensions are entered as footing length, width and 

thickness. The soil allowable bearing capacity, the concrete cover and the 

reinforcement in both directions are also entered. The program determines 

the ultimate axial load capacity that the footing can carry.  

5.2 Designing Reinforced Concrete Sections: 

The program has the ability of designing reinforced concrete sections of 

beams, columns and single footing.  

The section property is defined by entering the section dimensions and the 

material properties are defined by entering fc’, fy and fys.  

The Beam Section: the user enters the values of the applied forces; 

bending moment, shear force, axial force (less than 0.1fc’Ag) and torsional 

moment. The program gives the required longitudinal (top and/or bottom) 

and shear reinforcement.  

The Column Section: the user enters the values of the applied forces. They 

may be axial force, torsional moment, shear forces in the major and minor 
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directions and bending moments in the two directions. In column design, it 

is required to know the values of the end moments that are very important 

in the moment magnification and section design. The program introduces 

axial force-bending moment capacities interaction diagrams in the two 

directions. Also, it introduces axial force-shear force capacities interaction 

diagrams in the two directions. It is required to specify the element type as 

found in sway special, sway intermediate, sway ordinary or nonsway 

moment resisting frame. The type of column element is very important in 

column section design. The column design factors can be modified.  

Footing: the column dimensions, the footing material properties, the soil 

allowable bearing capacity, the concrete cover and the axial load on the 

column should be entered for footing design. The program gives the 

footing dimensions and reinforcement.  

The program supports different types of loads; dead, live, earthquake, wind 

and other loads. In column design, the dead and live loads form the 

nonsway forces, while the earthquake, wind and other loads form the sway 

forces.  

There are eleven load combinations that the program deals with. The load 

combination factors depend on the American Concrete Institute (ACI) code 

of practice. The factors in each load combinations can be overwritten.  

In the output, the details for each design load combination can be displayed 

and printed. All tables in the output process can be printed. The design 

reinforcement details can be displayed and printed.  

5.3 Getting Started with the Program:  
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In this section, the procedure of using the program will be illustrated. A 

Help file supports the program. The following sections illustrates the 

detailed use of the program.  

5.3.1 Language and Units: 

The program supports the Arabic and English languages and ton-meter and 

kilonewton-meter units. These can be determined soon after running the 

program. 

5.3.2 Starting a New Project:  

From the File menu, select New Project. This will display the New Project 

dialog. You can choose Analysis or Design modes and enter the number of 

sections you decide to design or analyze. Through running the program, 

you can add other sections by selecting the Edit menu and then Add. Also, 

you can rename or delete element sections by selecting Modify or Delete 

from the Edit menu respectively.  

5.3.3 The Define Menu 

The Define menu consists of three submenus: Materials, Sections and 

Design Load Combinations.   

 

5.3.3.1 The Materials Submenu 

From the Define menu, you can select Materials to define the material or 

materials properties. From the Define Materials dialog, you can add, 

modify or delete a material. You can modify the material properties by 

choosing the command button Modify/Show Material that displays the 

Material Property Data dialog. You can enter the values of the concrete 
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compressive strength, fc’, the main steel yield strength, fy, and the 

transverse steel yield strength, fys.  

5.3.3.2 The Sections Submenu 

Select Section from the Define menu. This will display the Define Sections 

dialog. You can add, modify or delete section or sections. The section 

properties can be shown or modified by clicking on the Modify/Show 

Section button. This will display the Show Section dialog. You can enter 

the section dimensions and the material name. Click on the Section Data 

command button to determine if the section is a beam or column, and if the 

section is column, does it has a footing to design or analyze. In the Section 

Data dialog, you can enter the concrete covers for a beam section and the 

concrete covers and height for a column section. If having a footing, 

choose Footing in the Column Data dialog and then click on the Define 

Footing button. This will display the Define Footing dialog. You can enter 

the values for the soil allowable bearing capacity, ultimate load factor (the 

factor that used to convert ultimate load to service load), and the concrete 

cover to rebar center.  

 

 

5.3.3.3 The Design Load Combinations Submenu 

From the Define menu, select Design Load Combinations.  This will 

display the define load combinations dialog. You can select your load 

combinations or modifying the load factors. You can return to the default 

values according to the ACI318-99 by clicking on Default Values 
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command button. The design load combinations combines the dead, live, 

wind and earthquake load cases together.  

5.3.4 The Assign Menu 

The Assign menu will be active after selecting the element section name or 

names from the element section list. In the design mode, Sections, Forces 

and Reinforcement Design Options submenus will be active, while in the 

analysis mode, Sections and Reinforcement submenus will be active.   

5.3.4.1 The Sections Submenu 

Select element section name or names from the elements list. From the 

Assign menu, select Sections. This will display the Sections dialog. From 

the sections list, select the section name. You can modify the section 

properties in this stage. 

 5.3.4.2 The Forces Submenu 

Select element section name or names from the elements list. From the 

Assign menu, select Forces. This will display the Forces dialog. The form 

of the dialog depends on the type of the section; beam or column. For a 

beam section, you can enter the values of the applied forces; bending 

moment, shear force, torsional moment and axial force for different types 

of load cases.  

For a column section, you can enter the values of the axial force, shear 

force in the major and minor directions, torsional moment and bending 

moments about the major and minor directions of the section for different 

load cases. The column end moments in the major and minor directions 

should be entered. Check on the Span Loads button if having span loads 

along the column height (this will affect the design parameters of column 
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section. See chapter two). Check on the Span Moments button if you want 

the program to design for specified values of bending moments and not the 

end moments. If the Span Moments button is checked off, the design will 

be for the end moments, and this is the usual case of column elements.  

5.3.4.3 The Reinforcement Submenu 

In the Analysis mode, select element section name or names from the 

elements list. From the Assign menu, select Reinforcement. This will 

display the Assign Beam Reinforcement dialog (for beam section) or the 

Assign Column Reinforcement dialog (for column section). There are two 

reinforcement options; Bars and Area options.  

Beam section: for the Bars option, the number of bars and the bar diameter 

for the top and buttom reinforcement and the number of stirrups (bars), bar 

diameter and bars spacing for shear reinforcement should be entered. For 

the Area option, the areas of the top and button main steel should be 

entered. For shear, the shear reinforcement, Av/S (Av: area of shear 

reinforcement in a section. S: stirrups spacing) should be entered.   

Column section: for Bars option, the number of bars in the major and 

minor directions and the bar diameter should be entered. The number of 

stirrups, the stirrup diameter and the stirrup spacing should be entered for 

the shear reinforcement.  For the Area option, the number of bars in the 

major and minor directions and the bar area should be entered. For shear, 

the shear reinforcement, Av/s should be entered.  If having a footing, the 

Footing Data command button will be active. Click on the Footing Data 

button. This will display the Assign Footing Dimensions and 

Reinforcement for Analysis dialog. In this dialog, the footing dimensions; 

the width, LB, the length, LH and the depth should be entered. The 
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reinforcement can be entered as bars or area. In the Bars option, the 

number of bars and bar diameter in the two directions should be entered. In 

the Area option, the area of steel in the two directions should be entered.  

5.3.4.4 The Reinforcement Design Options Submenu 

In the Design mode, select element section name or names from the 

elements list. From the Assign menu, select Reinforcement Design 

Options. This will display the Reinforcement Design Options dialog. By 

using this submenu, you can assign the reinforcement arrangement and 

diameters. For a column section, you can choose Bars Layout or Bars 

Diameter reinforcement options. In the Bars Layout option, you will enter 

the number of bars in the two directions and the transverse reinforcement 

bar diameter. The program will give the area of one bar. In the Bars 

Diameter option, you will enter the bar diameters of the main and 

transverse reinforcement and the program will give the bars layout 

(distribution). For a beam section, Bars Diameter option only is active. So 

you can enter the bars diameters for the main (longitudinal) and transverse 

bars.  

 

5.3.5 The Analyze Menu 

Click on Start Analysis/Show Results menu to run the analysis. This will 

display the Show Analysis Output dialog.  

For the beam section, the design positive (Beam/M+) and the design 

negative (Beam/M-) moments and the shear capacity (Shear Vd2) will be 

displayed in the analysis output table. You can display the axial load-shear 

capacity interaction diagram by clicking on the Pu-Vu2 command button. 

This will display the interaction diagram dialog (form). Moving the mouse 
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pointer shows the coordinates of the specified point. Click on Show 

Interaction Points button to display a table shows the main points of the 

interaction curve. From the Show Analysis Output dialog, you can display 

the details of the analysis process. 

For the column section, the shear capacities in the major and minor 

directions (Shear/Vd2 and Shear/Vd3 respectively) will be displayed in the 

analysis output table. You can display the axial force-bending moment 

interaction diagrams in the major and minor directions by clicking on Pu-

Mu2 and Pu-Mu3 command buttons. This will display the interaction 

diagram dialog. Moving the mouse pointer shows the coordinates of the 

specified point. Click on Show Interaction Points button to display a table 

shows the main points of the interaction curve. You can display the values 

of axial forces and bending moment’s capacities for a given eccentricity 

and the value of a bending moment capacity at a given axial load. This will 

be achieved by selecting the Check Points menu from the Column 

Interaction Diagram dialog. The axial force-shear capacity diagrams can 

also be displayed as for the beam section. If having a footing, the Footing 

Analysis command button will be active. Click on Footing Analysis button 

to run footing analysis. This will display the Footing Analysis Details 

dialog.  

5.3.6 The Design Menu 

This menu consists of two submenus. They are Start Design/Show Results 

and Redefine Element Design Data.  

5.3.6.1. The Start Design/Show Results Submenu  

Click on the Start Design/Show Results submenu to run the design 

process. This will display the Show Design Output dialog.  
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For a beam section, the required areas of steel (Ast Top and Ast Bot); the 

top and bottom areas of steel for flexure and the shear reinforcement (Av/S 

2) and torsion reinforcement (transverse reinforcement Av/S 2 and 

longitudinal T Al2) will be displayed. You can display the design output 

for each load combination by selecting the Load Combinations button. 

This will display a table of output design for the different load 

combinations. Select a load combination and then click on Details button. 

This will display the design details for the selected load combination. You 

can display the designed section reinforcement details by clicking on the 

Show Bars Layout button. This will display the Show Bars Layout dialog. 

You can change the bars diameters by clicking on the Change Bar 

Diameter menu.  

For a column section, the main steel (Ast), the shear steel in the major and 

minor directions (S Av/S 2 and S Av/S 3) and  the torsion steel (transverse 

T Av/S2 and T Av/S 3 and the longitudinal T Al2 and T Al3) will be 

displayed. You can display the reinforcement for each load combination by 

clicking on the Load Combinations button. This will display the table of 

reinforcement for the different load combinations. Select a load 

combination and then click on Details button. This will display the details 

of the design process for the specified load combination. You can display 

the axial force-bending moment capacities in the major and minor 

directions as in the Analysis Mode. If having a footing to be designed, the 

Footing Design button will be active. Click on the button. This will display 

the Show Footing Design dialog that shows the design output. You can 

display the reinforcement details for the footing by clicking on Show Bars 

Layout menu. This will display the Show Bars Layout dialog. You can 

change the bars diameters by clicking on Change Bar Diameter menu. 
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From the Design Output dialog, you can display the bars layout details for 

the column section by clicking on the Bars Layout button.  

5.3.6.2 The Redefine Element Design Data Submenu 

In the Design mode, select element section name or names from the 

elements list. From the Design menu, select Redefine Element Design 

Data. This will display the Redefine Element Design Data dialog. The 

column element should be determined as found in sway special, sway 

intermediate, sway ordinary or nonsway moment resisting frame. The type 

of the frame specifies column design parameters. From this dialog, you can 

select the column element type. Also, the design parameters can be 

modified. The design parameters deal with column length, the effective 

length factors, the moment coefficients, Cm and the sway and nonsway 

coefficients. The value of zero indicates that the program uses default 

values.  

5.3.7 The Options Menu 

In this menu, the values of the strength reduction factors; bending, tension, 

compression, shear and torsion can be modified. The default values are 

according to the ACI code of practice.  

For the column section, the minimum and the maximum steel ratios and the 

reduction factor for minimum eccentricity can be modified. For the footing 

section, you can modify the minimum footing thickness. 

5.3.8 The Help Menu 

From the Help menu, the help file can be displayed. The help data will be 

displayed in Arabic for the Arabic language and will be displayed in 

English for the English language.  
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One can press the F1 key to get information about the active dialog or 

operation. 

5.3.9 Saving and Opening Files 

The data file can be saved by selecting Save from the File menu. Also, 

selecting Open from the File menu can open the saved data file.  

5.3.10 Printer Setup 

The program supports the Print Setup menu. One can determine the printer 

type, paper size and paper orientation. To change the default printer setup, 

select Print Setup from the File menu.  

5.4 Brief steps in using AD RCS 

The main points of using AD RCS in design are as follows: 

1.  From the first beginning, select language and units. 

2. From the file menu, select New Project: select the Design option and 

enter the number of element sections to be designed. 

3. From the Define menu, select Materials to enter the concrete properties 

4. From the Define menu, select Sections to define the dimensions, element 

type beam or column and if a column has footing to be designed 

5. From the Define menu, select load combinations to customize your 

own load combinations 

6. Select element section or sections from the element sections list to 

assign a section, forces and reinforcement design type to the selected 

element section or sections using the Assign menu. 
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7. From the design menu, select Start Design/ Show Results the output 

will be displayed. 

 The main points of using AD RCS in analysis are as follows: 

1.  From the first beginning, select language and units. 

2.  From the file menu, select New Project: select the Analysis 

option and enter the number of element sections to be 

analyzed. 

3. From the Define menu, select Materials to enter the concrete 

properties. 

4. From the Define menu, select Sections to define the dimensions, element 

type beam or column and if a column has footing to be analyzed. 

5. Select element section or sections from the element sections list to 

assign a section and reinforcement to the selected element section or 

sections using the Assign menu. 

6. From the analyze menu, select Start Analysis/ Show Results the 

output will be displayed. 

5.5 The Programming Language 

The program is achieved and appears in reality using Visual Basic 6 

programming language. This language is a quick and professional 

language. It contains complete and abbreviate statements more than other 

languages like Visual C++, Visual Fortran and Visual Java. Also, it can be 

studied in shorter time than other languages.  
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The program was compiled and it is found in the attached compact diskette. 

This program is beginning in the local programming capabilities. I hope to 

develop and extend its capabilities.  
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Chapter Six 
Problems Verification 

In this chapter, three problems will be introduced. These problems will be 

solved manually and using the computer program AD RCS.  

6.1 Problem One: Design of Rectangular Beam Section for Bending, 

Shear and Torsion: 

Design a rectangular beam section of 35cm width and 65cm depth that 

subjected to ultimate bending moment of 30t.m, ultimate shear force of 20t 

and ultimate torsional moment of 6t.m. fc’= 280kg/cm2, fy=4200kg/cm2, 

fys=3500kg/cm2, top and bottom concrete cover= 5cm, sides cover= 6cm,  

main steel diameter= 20mm and shear steel diameter= 10mm. 

Solution: 

Design for bending moment: 

Section effective depth, d= 65-5=60cm 

The concrete compressive block depth, a: 
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Design for shear and torsion: 

Vu=20t, Tu=6t.m 

1. Calculate the section torsional capacity, Tuc: 

 

2. Check section adequacy. The section should satisfy the following 

equation: 
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3. Calculate the required torsional transverse steel and the total 

transverse  

steel: 

 

 

shear reinforcement: 

Vc=18.624t, Vu=20t 

 

Using 10mm diameter stirrups , Av=2(3.1416(1)2/4)=1.57cm2 

 

 

Check spacing: 

Smax= smaller of Ph/8 or 30cm 

Smax=156/8=19.5cm>7.44 ok 
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4. Calculate torsional longitudinal steel: 

 

 

The final longitudinal steel can be distributed as follows: 

bottom steel: As=14.058+12.2/4=17.108cm2(6Φ20mm) 

middle steel: As= 12.2/2=6.1cm2(2Φ20mm) 

top steel: As= 12.2/4=3.05cm2(1Φ20mm), at least use (2Φ20mm) 

 

This problem is solved using AD RCS program and the results are shown 

in the following pages. 
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6.2 Problem Two: Design of  a Long Column with various Loads: 

Design a reinforced concrete column, given: 

Concrete compressive strength, f'c=240kg/cm2 

Steel yield strength, fy=4200kg/cm2 

Column height=4m 

Effective length factor, k=2 (unbraced column) 

Column dimensions: 70x70cm 

There are two layers of steel only (tension and compression steel of the 

same area) 

Loads: 

 Dead loads:   PD=280t 

    MD top=-13t.m 

    MD bottom=9t.m 

 Live loads:    PL=134t 

    ML top=-7t.m 

    ML bottom=5t.m 

 Earthquake loads:  PE=60t 

    ME top=-23t.m 

    ME bottom=47t.m 

 Concrete cover to centroid of bars=7cm 

Solution: 

The slenderness ratio kl/r is calculated as follows: 
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Calculating the ultimate loads from load combinations: 

The load combinations from the ACI318-99 are: 

Combination1: U=1.4D 

Combination2: U=1.4D+1.7L 

Combination3: U=0.75(1.4D+1.7L+1.87E) 

Combination4: U=0.75(1.4D+1.7L-1.87E) 

Combination5: U=0.9D+1.43E 

Combination6: U=0.9D-1.43E 

It is very important to distinguish between the sway and nonsway loads, the 

gravity loads cause inconsiderable lateral deflection and so they are 

considered as nonsway loads. The earthquake loads cause considerable 

lateral deflection to the structure and so they are considered as sway loads.  

A typical solution of this problem requires calculating the sway and 

nonsway moments in each load combination and then determining the 

magnification factors and the final design moments. The program AD RCS 

calculates the design moments and axial force for each load combination 

and gives the required area of steel for the design loads for each load 

combination. This is very long for hand calculations. In this problem the 

load combination3 is the critical and it will give the largest design 

combination of the bending moment and axial force. The load 

combination3 gives the maximum bending moment. The following 

calculations are done for load combination3. 
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Calculate the magnification factors: 

The nonsway magnification factor, δns: 

 

 

Applying the previous equations:  
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The sway magnification factor, δs: 

 

The design moment will be: 
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So, the section should be designed for: 

Pu=549t 

Mu=104.15t.m 

The program AD RCS tries a steel ratio and does calculations for values of 

the neutral axis depth to reach the section capacity that is at least equals the 

applied design loads.  

By trial and error ρ=0.02 and the depth of neutral axis, C=53.2cm 

The stresses in the steel and then the axial force and bending moment 

capacities will be calculated. 
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This problem is solved using AD RCS computer program and the results 

are shown in the following pages. 
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6.3 Problem three: Design of Single Footing: 

Design a single footing that carries a service dead load of 120t and a 

service live load of 90t. Fc’=200kg/cm2. Fy=4200kg/cm2. Soil allowable 

bearing capacity, Qa=30t/m2. Concrete cover=10cm. Column dimensions: 

30x60cm.  

Solution: 

1. Find footing area and dimensions: 

 

Find footing depth: 

Check d for punching shear: 

 

So, the effective depth, d should be increased. 

By trial and error or by solving equations, d=0.55m 

Footing total depth= 0.55+0.1=0.65m 
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2. Calculate areas of flexural steel: 

 

 

This problem is solved using the AD RCS computer program and the 

results are shown in the following pages. 
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Chapter Four 
Quick Tutorials 

In this chapter, quick tutorials will be introduced to make the user familiar 

with the program. Two examples will be solved using the program and the 

detailed steps are to be introduced. The first example will be analysis of 

two sections; beam and column sections. The second will be design of two 

sections; beam and column. 

4.1 Tutorial one: 

Analyze the following two sections: 

section 1: beam, width = 40cm, depth = 70cm, bottom steel = 6 Ф 25mm, 

top steel = 4 Ф 16mm, concrete cover to longitudinal bars center =  6cm, 

f'
c= 240kg/cm2, fy= 4200kg/cm2. Shear reinforcement: 1 Ф10mm/15cm.  

Section 2: column, width = 30cm, depth = 50cm, concrete cover = 5cm, 

reinforcement = 10 Ф 18mm (2 bars 5 layers with equal spacings), f'
c= 

200kg/cm2, fy= 4200kg/cm2.  

Shear reinforcement: 1 Ф10mm/15cm. 

Steps: 

1. Click on the program icon or short cut in the computer, the first 

dialog of the program will be displayed showing the name of the 

program and then the Analysis and Design of Reinforced Concrete 

Sections dialog box will be displayed as shown in Figure 4.1. Click 
on the option "  (English)  انجليـزي" and on the option "  طـن متـر (ton. 

Meter)" to choose the English language and the ton. meter units. 

Click ok. This will display the program main form with the menu 

and the tool bar. 
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2. Select New Project from the File menu. This will display the New 

Project dialog box. Write project1 in the text box Project Name and 

select analysis then write 2 in the text box  Number of Sections to 

Analyze. Then click ok. This will display a list of the element 

sections to be analyzed at the top left corner of the program screen.  

3. From the Define menu, select Materials. This will display the 

Define Materials dialog box as shown in Figure 4.2. Two materials 

are to be added because of having two types of materials for the 

beam and column sections 

Figure 4.1 Analysis and Design of Reinforced Concrete Sections dialog 

box  

Figure 4.2 Define Materials dialog box 
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Click on the Modify/Show Material button to modify or set the 

material properties. This will display the Material Property Data 

dialog. In this dialog set the values of the concrete compressive 

strength and the main and shear steel yield strength in the specified 

text boxes; the concrete compressive strength, f'
c= 2400t/m2 and the 

steel yield strength for the main steel and shear steel are 42000t/m2. 

Click ok to accept the values for the material of the first element 

section.  

Click on the Add New Material command button to add a new 

material. This will display the Material Property Data dialog box. 

In this dialog, set in the edit boxes the concrete compressive strength 

to 2000t/m2 and the steel yield strength of the main and shear steel to 

42000t/m2. Then click ok. (The material name is concrete2, one can 

change the name of material at any stage of program running). The 

two materials are displayed in the Materials list in the Define 

Materials dialog box. Click ok. (you can rename the materials as 

beamCon and ColumnCon, for example). 

 

4. From the Define menu, select Sections. This will display the 

Define Frame Sections dialog box.  Click on the Modify/Show 

Section command button. This will display the default Show 

Rectangular Section dialog box. In this dialog, write 0.7 in the 

depth, HW text box and write 0.4 in the Width, BW text box. The 

size of the rectangular section in the picture will be modified. The 

material type is concrete1 as it is found in the list besides the 
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Materials label. Click on the Section Data command button to 

specify further properties of FRSEC1 section. This will display 

the Beam- Column Data dialog box. In this dialog, set the 

concrete cover to rebar center to 0.06 for the top, bottom and 

sides covers. The Beam option is chosen (see Figure 4.3). Then 

click ok to accept the input data. Click ok in the Show 

Rectangular Section dialog to accept the data of the first section.  

Select Add Rectangle from the Add New Section List. This will 

display the Add Rectangular Section dialog box.  In this dialog, the 

name of the section is FRSEC2. Select concrete2 for the material 

name. Set the depth to 0.5 and the width to 0.3 as shown in Figure 

4.4. Click on the Section Data command button to specify further 

settings. This will display the Beam-Column Data dialog box. In 

this dialog, click on the column option. Write 0.05 in the text box for 

the concrete cover to rebar center. The column height is not needed 

for determining section interaction diagram, so no need to change the 

column height. Click ok and then click ok in the Add Rectangular 

Section dialog box. The two sections will be displayed in the 

sections list in the Define Frame Sections dialog box. Click ok.    
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Figure 4.3 Beam Data dialog box 

 

 

Figure 4.4 Show Rectangular Section dialog box for section2  
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5. The section names should be assigned to the element sections in the 

elements list. Click on the first element section ElSection1 in the 

elements sections list and then select the Sections submenu from the 

Assign menu. This will display the Define Frame Sections dialog. 

Click on FRSEC1 from the sections list to assign this name to the 

first element section  ELSection1 in the list then click ok.  

Click on the ELSection2 in the elements sections list. Select the 

Sections submenu from the Assign menu. This will display the Define 

Frame Sections dialog. Click on FRSEC2 from the sections list to 

assign this name to the second element section  ELSection2 in the list 

then click ok as shown in Figure 4.5.  

Figure 4.5 Assign FRSEC2 to ELSection2 element section 
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6. The reinforcement will be assigned to the element section in this 

step. Click on the ELSection1 in the element sections list, then select 

Reinforcement submenu from the Assign menu. This will display 

the Assign Beam Reinforcement dialog box. In this dialog, the top 

steel is 4 bars of 16mm diameter and the bottom steel is 6 bars of 

25mm diameter. The shear reinforcement is 1 stirrup of 10mm 

diameter at 15cm spacing as shown in Figure 4.6. click ok.  

Click on the ELSection2 in the element sections list and then select 

Reinforcement submenu from the Assign menu. This will display the 

Assign Column Reinforcement dialog box.  No. of rebars in direction 

3-3 is 2, no. of rebars in direction 2-2 is 5 (10 bars) and the bar diameter 

is 18mm. For shear reinforcement, the number of bars is 1, the bar 

diameter is 10mm and the bars spacing is 15cm. Click ok.  

Figure 4.6 Assign Beam Reinforcement dialog box 
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7. From the Analyze menu, select Start Analysis/ Show Results 

submenu, this runs the analysis and displays the Show Analysis Output 

dialog box as shown in Figure 4.8.  

 

Figure 4.7 Assign Column Reinforcement dialog box 

  

Figure 4.8 Show Analysis Output dialog box 
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 Figure 4.9 P-V2 Beam Interaction Diagram dialog box 

 

Figure 4.10 Display Interaction Points of Beam 1 P-V2 dialog box  
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Click on the Pu-Vu2 command button to display the interaction curve 

between the axial load and the shear force capacities of the analyzed beam 

section, this will display the P-V2 Beam interaction diagram as shown in 

Figure 4.9. The diagram shows the design shear capacity, Vd and the 

concrete shear capacity ФVc. moving the mouse pointer on the diagram 

will display the coordinates of the point; the applied axial force and the 

corresponding design shear capacity, Vd.  Click on the Show Interaction 

Points command button to display the points of the P-V diagram in table. 

This will display the Display Interaction Points of Beam1 P-V2 dialog 

box (table) as shown in Figure 4.10.   

Close the displayed two dialog boxes. Click on the Details command 

button, this will display the Show Beam Section Analysis dialog box as 

shown in Figure 4.11. This dialog shows details of analysis of the beam 

section. 

Figure 4.11 Show Beam Section Analysis dialog box  

 

Close the dialog.  
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Click on the second element section in the Show Analysis Output dialog, 

this will activate other command buttons that are related to column 

sections.  

Click on the Pu-Mu3 command button to show the axial force - bending 

moment capacities interaction diagram. This will display the P-M3 

Column Interaction Diagram dialog box as shown in Figure 4.12. 

Moving the mouse pointer on the diagram will show the axial force and the 

bending moment capacities at a point. Click on Show Interaction Points 

command button to show the tabled points of the interaction diagram as 

shown in Figure 4.13. This will display the Display  Interaction Points of 

Column 2 P-M3 dialog box.   

 

Figure 4.12 P-M3 column Interaction Diagram dialog box  
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Figure 4.13 Display Interaction Points of Column 2 P-M3 dialog box 

Close the last displayed dialog.  

In the P-M3 Column Interaction Diagram dialog box, click on the Check 

Points menu to get the values of the axial force and bending moment 

capacities at a specified eccentricity and the bending moment capacity at a 

specified axial force. This will display the Calculating Interaction Points 

dialog box. If it is required to find the axial force and the bending moment 

capacities of the column at 0.15m eccentricity,  click on Eccentricity, e 

option button and then write 0.15 in the eccentricity text box. Click ok, the 

values of the capacities will be displayed in the output results frame as 

shown in Figure 4.14. 
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Figure 4.14 Calculating Interaction Points dialog box  

 

Close the displayed forms except the Show Analysis Output dialog box. 

Click on the Details command Button to see the analysis details of the 

column section. This will display the Show Column Section Analysis 

dialog box as shown in Figure 4.15.  

  

Figure 4.15 Show Column Section Analysis dialog box 
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8. From the File menu, select Save. This will display the Save As 

dialog box. Select the directory you wish to save the file in and then 

write the name of file in the File name edit box, for example, write 

tutorial1, then click on the Save button. The program saves only the 

input data.  

9. The saved file can be opened by selecting the Open menu from the 

File menu. 

4.2 Tutorial Two: 

Design the following two sections: 

section 1: beam, given: width = 80cm, depth = 30cm, concrete cover to 

longitudinal bars center =  5cm, f'
c= 240kg/cm2, fy= 4200kg/cm2, ultimate 

positive bending moment = 15t.m, ultimate shear force = 20t, use Ф18mm 

for main steel and Ф8mm for shear reinforcement. 

Section 2: column, given: width = 30cm, depth = 50cm, concrete cover = 

5cm, reinforcement configuration: use 10 bars,  (2 bars 5 layers with equal 

spacings), f'
c= 200kg/cm2, fy= 4200kg/cm2. Dead loads: P=60t, M3 top= 

6t.m, M2 top= 4t.m. Live loads: P=40t, M3 top=5t.m, M2 top= 2t.m.  

Column height= 3m.  

Steps: 

1. Click on the program icon or short cut in the computer, the first 

dialog of the program will be displayed showing the name of the 

program and then the Analysis and Design of Reinforced Concrete 

Sections dialog box will be displayed. Click on the option "  
(English) انجليزي" and on the option " طن متـر (ton. Meter)" to choose the 
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English language and the ton. meter units. Click ok. This will display 

the program main form with the menu and the tool bar. 

2. Select New Project from the File menu. This will display the New 

Project dialog box. Write project2 in the text box Project Name and 

select Design then write 2 in the text box  Number of Sections to 

Design. Then click ok. This will display a list of the element sections 

to be designed at the top left corner of the program screen.  

3. From the Define menu, select Materials. This will display the 

Define Materials dialog box. Two materials are to be added because 

of having two types of materials for the beam and column sections.  

Click on the Modify/Show Material button to modify or set the 

material properties. This will display the Material Property Data 

dialog box. In this dialog set the values of the concrete compressive 

strength and the main and shear steel yield strength in the specified text 

boxes; the concrete compressive strength, f'
c= 2400t/m2 and the steel 

yield strength for the main steel and shear steel are 42000t/m2. Click ok 

to accept the values for the material of the first element section.  

Click on the Add New Material command button to add a new material 

for the second section. This will display the Material Property Data 

dialog box. In this dialog, set in the edit boxes the concrete compressive 

strength to 2000t/m2 and the steel yield strength of the main and shear 

steel to 42000t/m2. Then click ok. (The material name is concrete2, one 

can change the name of material and/or the material properties at any 

stage of program running). The two materials are displayed in the 

Materials list in the Define Materials dialog box. Click ok.  
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4. From the Define menu, select Sections. This will display the Define 

Frame Sections dialog box.  Click on the Modify/Show Section 

command button. This will display the Show Rectangular Section 

dialog box. In this dialog, write 0.3 in the depth, HW text box and 

write 0.8 in the Width, BW text box. The size of the rectangular 

section in the picture will be modified. The material type is 

concrete1 as it is found in the list besides the Materials label. Click 

on the Section Data command button to specify further properties of 

FRSEC1 section. This will display the Beam Data dialog box. In 

this dialog, set the concrete cover to rebar center to 0.05 for the top, 

bottom and sides covers. The Beam option is chosen. Then click ok 

to accept the input data. Click ok in the Show Rectangular Section 

dialog to accept the data of the first section.  

Select Add Rectangle from the Add New Section List. This will 

display the Add Rectangular Section dialog box.  In this dialog, the 

name of the section is FRSEC2. Select concrete2 for the material name. 

Set the depth to 0.5 and the width to 0.3. Click on the Section Data 

command button to specify further settings. This will display the Beam 

Data dialog box. In this dialog, click on the column option. Write 0.05 

in the text box for the concrete cover to rebar center. Click ok and then 

click ok in the Add Rectangular Section dialog box. The two sections 

will be displayed in the sections list in the Define Frame Sections 

dialog box. Click ok.    

5. The section names should be assigned to the element sections in the 

elements list. Click on the first element section ElSection1 in the 

elements sections list and then select the Sections submenu from the 
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Assign menu. This will display the Define Frame Sections dialog. 

Click on FRSEC1 from the sections list to assign this name to the 

first element section  ELSection1 in the list then click ok.  

Click on the ELSection2 in the elements sections list. Select the 

Sections submenu from the Assign menu. This will display the Define 

Frame Sections dialog. Click on FRSEC2 from the sections list to 

assign this name to the second element section  ELSection2 in the list 

then click ok.  

6. From the Define menu, select Design Load Combinations. This 

will display the Define Load Combinations dialog box as shown in 

Figure 4.16. The default load combinations are for ACI318-99. The 

factors in each load combination can be modified. Check on the last 

load combination to be used for the beam section, as the loads are the 

ultimate for the beam section. Click ok. 

7. Select the first element section from the element sections list. Then, 

from the Assign menu select Forces. This will display the Assign 

Beam Forces dialog box. In this dialog, write 20 in front of the load 

case other and under Shear2 and write 15 under Moment3 as shown 

in Figure 4.17 (axis 2 is the vertical and axis 3 is the horizontal). 

Click ok.  
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Figure 4.16 Define Load Combinations dialog box  

 

8. Select the second element section from the element sections list. 

Then from the Assign menu select Forces. This will display the 

Assign Column Forces dialog box. In this dialog, write 60 and 40 

for the dead and live axial loads respectively. Also, write 6 and 4 for 

Moment3 and Moment2 dead loads respectively as top moments. 

And write 5 and 2 for Moment3 and Moment2 live loads top 

moments respectively as shown in Figure 4.18. Click ok.  
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Figure 4.17 Assign Beam Forces dialog box  

 

Figure 4.18 Assign Column Loads dialog box 
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9. Select the first element section in the elements sections list and then 

click on the Assign menu and select Reinforcement Design Options 

menu. This will display the Assign Beam Reinforcement dialog box as 

shown in Figure 4.19. In this dialog, change the bars diameter from 

16mm to 18mm. Then click ok.  

 

Figure 4.19 Assign Beam Reinforcement dialog box 

 

10.  Select the second element section in the elements sections list and 

then click on the Assign menu and select Reinforcement Design 

Options menu. This will display the Assign Column 

Reinforcement dialog box as shown in Figure 4.20. In this dialog, 

click on the option Bars Layout. Write 2 and 5 for the bars in 

directions 3 and 2 respectively.  

11. From the Design menu, select Start Design/Show Results. This will 

display the Show Design Output dialog box as shown in Figure 

4.21. 
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Figure 4.20 Assign Column Reinforcement dialog box  

 

Figure 4.21 Show Design Output dialog box 
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Click on the first row in the table (the beam section). Then click on the 

command button Bars Layout, this will display the Show Bars Layout 

dialog box as shown in Figure 4.22.  Then close the dialog box.  Click on 

the button Load Combinations, this will display a table for the design 

output of the eleven load combinations as shown in Figure 4.23.   

 

Figure 4.22 Show Bars Layout dialog box for the beam section 

 

Figure 4.23 Load combinations design output for the beam section 
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One can select (click on) any load combination in the table and then clicks 

on the button Details to display some details of the analysis procedure.  

Click on the second element section in the table. This will activate the 

Column P-M3 Diagram and Column P-M2 Diagram buttons. Clicking 

on these buttons will display the axial load- bending moment interaction 

diagrams in the major and minor direction of the column respectively.  

Click on the button Bars Layout. This will display the section 

reinforcemnet details as shown in Figure 4.24.  

Figure 4.24 Show bars Layout dialog box for the column section 

 

From the bars layout dialog box, the reinforcement needed is 10 Ф27mm 

bars. This reinforcement is not practical. The reinforcement configuration 

(bars distribution) can be changed and so the final reinforcement will be 

achieved. The reinforcement configuration can be modified by selecting the 

column section from the sections elements list and select Design 

Reinforcement Options from the Assign menu and redo the design.  
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Detailed description of steps for using the program will be introduced in 

the following chapter; chapter five and verification problems will be 

introduced in chapter six. 
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  ملخص

الخرسـانية المسـلحة   وتصميم المقـاطع  ) تقييم(هناك حاجة لا شك فيها لإيجاد برنامج لتحليل 

أيضا هناك ضرورة لإيجاد برنامج باللغـة  . لاهداف التعليم الأكاديمي وخدمة المكاتب الهندسية

  .العربية ليساعد الاتصال والتفاهم بين المهندسين العرب  الذين تخرجوا من جامعات مختلفة

تقدم هذه الرسالة برنامج حاسوب يحاول سد الحاجات المذكورة سابقا معتمدا على تعليمات الكود 

) طـن، متـر  (وباللغات العربية والإنجليزية وباستخدام الوحدات المحليـة    ACI-99الأمريكي 

  ).كيلو نيوتن، متر(والوحدات العالمية 

لخرسانية، قد تم تنفيذه واخراجه باسـتخدام  إن برنامج الكمبيوتر المقدم، تحليل وتصميم المقاطع ا

حيث يكون الإدخال والإخراج في هذا البرنامج ) لغة بيسك المرئية( 6لغة البرمجة فيجوال بيسك 

  .(windows)من خلال نوافذ ويعمل البرنامج تحت بيئة برنامج النوافذ 

سلحة من مقـاطع جسـور   وتصميم المقاطع الخرسانية الم) تقييم(إن للبرنامج القدرة على تحليل 

كمـا يقـدم   . واعمدة وقواعد منفصلة لقوى عزم الانحناء والقص والقوى الرأسية وعزم اللـي 

كما . البرنامج رسومات العلاقات بين العزم والقوى الرأسية في الأعمدة وبين العزم وقوى القص

  .ل البرنامجيقدم أيضا رسومات تفصيلية لحديد التسليح في المقطع الذي يتم تصميمه من قب

  


